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1. Overview 
 
 Revo Uninstaller Pro helps you uninstall software and remove unwanted programs, 
installed on your computer, even when you have problems uninstalling and cannot 
uninstall them from "Programs and Features" ("Windows Add or Remove Programs") 
Windows Control Panel applet. 
 
 Revo Uninstaller Pro is a much faster and more powerful alternative of the 
"Programs and Features" ("Windows Add or Remove Programs") application, that allows 
you to efficiently manage your installed programs. 
 
 Any program may leave a lot of data in your computer after its removal. There are 
tens of thousands of applications that leave a lot of unused data, such as Registry entries 
and files and folders in your computer. Not all leftover Registry keys in your computer are 
errors, so third party Registry cleaners cannot detect them. Leftover Registry keys, in 
combination with leftover files, make the Registry cleaner's job ineffective. Revo 
Uninstaller Pro helps you remove the Registry keys, files and folders, left by the program 
you uninstall. 
 
 With its advanced and fast algorithms, Revo Uninstaller Pro analyzes the 
application's data before uninstall and scans your computer for leftovers after the built-in 
uninstaller of the program you are uninstalling finishes. After the program's regular 
uninstaller runs, you can remove additional unnecessary files, folders and Registry keys, 
usually left over on your computer.  
 
 Even if you have a broken (corrupt) installation of an application, Revo Uninstaller 
Pro can scan your hard disk drives and Windows Registry and show all files, folders and 
Registry keys found, so you can delete them easily. 
 
 Revo Uninstaller Pro has a very powerful feature called Forced Uninstall.  With this 
feature you can remove leftovers of programs that are already uninstalled, incomplete 
installations and remnants of programs. It does not matter if the program you want to 
remove is not listed in "Programs and Features" Control Panel application. Forced Uninstall 
is the best solution when you have to remove partially installed programs, partially 
uninstalled programs, and programs not listed as installed at all. 
 
 With its unique Hunter mode, Revo Uninstaller Pro offers you some simple, easy to 
use, but effective and powerful software removal features. You can use it to manage your 
installed and/or running programs directly from your desktop, using their icons or opened 
windows. 
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 Revo Uninstaller Pro has another feature, which allows monitoring installation of a 
program for complete uninstall. It detects system changes during the installation. The 
process is done in real time – simultaneously with the installation. This feature is also very 
powerful, because, by monitoring system changes during the installation, we eliminate the 
necessity of all the scanning algorithms, applied during uninstall, so you can use the 
installation log for complete removal of the program, just as if it has never been installed at 
all. 
The Export and Import Log commands let you share logs with anyone using Revo 
Uninstaller Pro quite easily, thus being sure you are doing the ultimate uninstall of the 
programs you have installed. For example, if you have problems uninstalling Program A or 
just want to do a better uninstall of Program A, and a friend of yours has installed and 
traced the same program and has a log, he can just export the log and send it to you. You 
can then import it and use it to uninstall the program just as if you have traced its 
installation yourself. 
 
 An important part of Revo Uninstaller Pro is the Logs Database. It is a database of 
logs of programs, traces through the monitoring module of Revo Uninstaller Pro, and 
managed by Revo Uninstaller Pro's team. Those logs are stored on our web site and you can 
easily (one click only) use them to uninstall a program with its respective log, or to 
uninstall leftovers of already uninstalled program.  
 
 For the best uninstall experience there is an integration between the installed 
programs, the user-made logs of traced programs, and the logs, maintained by the Logs 
Database, so, when you start uninstalling a program from the list of all installed 
applications, Revo Uninstaller Pro will search for the best possible way to uninstall the 
program and decide if a log, if any, whether traced by the users or maintained by Logs 
Database, can be used for the process.  
 
 Revo Uninstaller Pro has a multi-level backup system. The Backup Manager is the 
main part of that system. It helps you manage backup information, stored by Revo 
Uninstaller Pro, such as deleted Registry entries, files and folders. The other levels of the 
backup system are  

- Creating system restore point before each uninstall 
- Full Registry backup before each uninstall 
- Full Registry backup once each day Revo Uninstaller Pro is started. 

 
 Revo Uninstaller Pro gives you another 8 handy and powerful tools to clean up your 
system. Here is the list of the tools and utilities included in Revo Uninstaller Pro: 
 
Auto Start Manager - Stop programs and services that start automatically on Windows 
startup; speed up loading of Windows; 
 
Windows Tools Manager - Handy and useful tools bundled with every version of 
Windows; easily find useful system tools and options; 
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Junk Files Cleaner - Find and remove unnecessary files from your computer; free up disk 
space and delete files you do not need; 
 
Browsers History Cleaner - Erase web browser history, visited pages history and 
temporary internet files of Internet Explorer, Firefox and Opera web browsers; free up a lot 
of disk space by deleting temporary internet files like temporary saved videos, temporary 
flash files, temporary pictures etc.; 
 
Office History Cleaner - Remove the history of most recently used files in MS Office; 
remove your tracks by deleting the list of last opened MS Office documents; 
 
Windows History Cleaner - Remove the history of recently opened files, delete temporary 
files, remove usage tracks and other history items that are saved by Windows; remove your 
tracks saved by Windows for a lot of operations; 
 
Unrecoverable Delete Tool - Erase files and folders forever; be sure that nobody could 
recover your files and folders after deleting; 
 
Evidence Remover - Make sure already deleted files, folders and other data are 
unrecoverable; securely erase your data. 
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2. User Interface 
 

 
 
 The main window of Revo Uninstaller Pro is divided into few movable and flexible 
user interface components. By default the Menu Bar is at the top of the main window. It 
can be turned on and off from the View menu, and it can be moved by dragging (pressing 
the mouse button over a place different than a menu item).  
 
 The Commands toolbar is located beneath the menu bar. It contains the available 
commands for the current active tool. The Commands toolbar can also be turned on and off 
from the View menu, and can be moved by dragging too (pressing the left mouse button 
over a part of the toolbar different than a button).  You can show or hide the text of the 
icons from the options. The size of the icons can be changed from the options too. 
 
 The Main toolbar contains some of the main features of Revo Uninstaller Pro. By 
default it is hidden, but it can be turned on from the View menu and, just like the 
Commands Toolbar it can be moved and resized from the Options. 



Revo Uninstaller Pro - User's Guide 

9 | P a g e  

 
 The Tools toolbar is located at the left side of the main window. It contains the 
tools, included in Revo Uninstaller Pro. Commands toolbar-like icon and text size 
adjustment is also available here.  
 
 At the bottom of the main window is the Status Bar. Depending on the active tool it 
can show some additional information. It can be turned on and off from the View menu.  
 
 The Description Panel is by default located above the status bar. It shows some 
common information about the active tool. It can be turned on and off from the View menu 
and it can be moved by dragging (pressing the mouse button anywhere in its window).  The 
Description Panel supports also an “auto hide” feature that hides and shows the panel on 
mouse over. To activate/deactivate the “auto hide” option press the small button with the 
shape of a pin in the right upper part of the panel window. 
When the All Programs or  Traced Programs module is activated and the shown list  is in 
Icon or List mode, the Description Panel is used as Details Panel when an item is selected, 
thus showing some of the important properties of the selected item. 
 
 Currently active tool is shown in the middle part of the main window.  Many tools 
can be open at the same time, but only one of them is active. To navigate among the open 
tools just press their tabs on top of the active window. You can also open a tool by pressing 
its button on the Tools toolbar or using the Tools menu. 
 
 
 

Keyboard shortcuts 

 

Tools: 

Tool Hotkey 

Uninstaller Alt+U 

Autorun Manager Alt+A 

Commands for Autorun Manager Hotkey 

Run Ctrl+R 

Kill Ctrl+K 

Add Ctrl+A 

Remove Ctrl+M 

Junk Files Cleaner Alt+J 
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Commands for Junk Files Cleaner Hotkey 

Scan Ctrl+S 

Delete Ctrl+D 

Windows Tools Alt+T 

Commands for Windows Tools Hotkey 

Run Ctrl+R 

Browsers Cleaner Alt+R 

Commands for Browsers Cleaner Hotkey 

Clear Ctrl+C 

Microsoft Office Cleaner Alt+M 

Commands for Microsoft Office Cleaner Hotkey 

Clear Ctrl+C 

Windows Cleaner Alt+W 

Commands for Windows Cleaner Hotkey 

Clear Ctrl+C 

Evidence Remover Alt+E 

Commands for Evidence Remover Hotkey 

Execute Ctrl+E 

Unrecoverable Delete Alt+D 

Commands for Unrecoverable Delete Hotkey 

Delete Forever Ctrl+D 

Add File(s) Ctrl+F 

Add Folder Ctrl+Shift+F 

Backup Manager Alt+B 

Options Alt+O 
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Modules: 

Module Hotkey 

All Programs Ctrl+Alt+A 

Traced Programs Ctrl+Alt+T 

Logs Database Alt+L 
 

All Programs module: 

Option Hotkey 

Install Programs Ctrl+L 

Print Ctrl+P 

Print Preview Shift+P 

Print Setup Ctrl+Shift+P 

Commands for All Programs Module Hotkey 

Uninstall Ctrl+U 

Quick Uninstall Ctrl+Q 

Refresh Ctrl+R 

Forced Uninstall Ctrl+F 
 

Traced Programs module: 

Option Hotkey 

Install Programs Ctrl+L 

Import Log Ctrl+I 

Export Log Ctrl+E 

Print Ctrl+P 

Print Preview Shift+P 

Print Setup Ctrl+Shift+P 

Commands for Traced Programs Module Hotkey 

Uninstall Ctrl+U 
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Custom Uninstall Ctrl+C 

Refresh Ctrl+R 

Edit Log Ctrl+D 
 

Logs Database module: 

Option Hotkey 

Print Ctrl+P 

Print Preview Shift+P 

Print Setup Ctrl+Shift+P 

Commands for Logs Database Module Hotkey 

Uninstall Ctrl+U 

Custom Uninstall Ctrl+C 
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3. Uninstaller 
3.1. All Programs 

 
 When Revo Uninstaller Pro is started, its main window shows installed programs on 
your computer. Depending on the settings, other items, such as system updates or system 
components may be listed also. Depending on the view setting, programs are shown as 
Icons, List, and with Details such as Name, Size, Version, Type, Installation Date, 
Company, Comment, Uninstall String, Registry Key and Website.  
 

 
 
 By default, installed programs are shown in Icons view and when you select a 
program in the Description Panel, some of the properties of the program, like: Icon, Size, 
Version, Install Data, Company, Update Link and Web Site, are shown below. Similar data 
you may also see when you hover the mouse cursor over a program in the list. In that case 
the data is shown as Tooltip, next to the mouse cursor. 
 In Details view you can right-mouse click on the column header and show or hide 
some of the columns. This way you can also choose what to print. Printing works only in 
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 Details view and that is why it is better to setup printing as Landscape view – to see 
much more info in one page.  
 
By default Revo Uninstaller Pro shows programs in Icons view in two groups: 
 New programs – programs installed last 7 days (the number of the days can be 
changed from the options) or since the last run of the uninstaller; 
 Other Programs – all programs that are installed before last 7 days, or before the 
last run of the uninstaller. 
 You can assign each program to a group by using the context menu, shown on right-
mouse click on a program. Removing a program from a group is also possible from the 
context menu. Default groups are Internet, Games, Multimedia and Utilities. Additional 
groups can be added from the options - Groups Manager - or directly from: 
 
  Context menu -> Add to Group -> Add new group  
 
 The selected item (with a right-mouse click on it) will be moved to the newly added 
group automatically.  
 
 Using the Search field in the upper part of the main window, you can filter the list of 
the programs by name, publisher or comment. When you type some text in the Search 
field, right below you will see the number of found programs that match the search criteria. 
 
 Revo Uninstaller Pro has a command to export installed programs to HTML, TXT 
and XLS (Microsoft Excel table). To use the command go to  
 

Main menu -> File ->Export to 
 
You can choose which details you can export. 
 
NOTE: To export installed programs to Microsoft Excel you must have Microsoft 
Excel installed and working properly.  
 

 
Some other commands available from the context menu are:  

Search at Google for – Use it to search with Google for the application name, or the 
publisher of the application. This command will open your default web browser and 
display the results of the search; 

Open About Link – This command will open your default web browser and load the 
address containing information about the application; 

Open Help Link – This command will open your default web browser and load the 
address containing help information; 

Open Update Link – This command will open your default web browser and load 
the address providing update information; 
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Install Location – Opens Windows Explorer, so you can see where the selected 
application is installed; 

Open Registry Key – Opens the Registry editor (RegEdit.exe) and displays the 
Registry key containing the uninstall information of the selected application; 

Add/Edit Comment – Opens a window to add a comment about the program or edit 
the comment if such already exists. The comment is visible in Details view; 

Change Icon – Opens a window to select a new icon for the program shown in the 
list. You can search for an icon in any EXE or DLL file. 

 
If during the uninstall the build-in uninstaller of the programs runs "Change" or 

"Repair" command and tries to reinstall or repair the program instead of uninstalling it 
then you can use the command Forced MSI Uninstall. This command is visible in the 
context menu only for the MSI(Microsoft Installer) programs, which default uninstall 
command is not Uninstall. So if you experience such problem, just cancel the build-in 
uninstaller of the program and the uninstall wizard of Revo Uninstaller Pro and start it 
again using this command from the context menu  

 
 In some cases, when a program from the list is selected, depending on the installer 
of that program, you may see on the Commands toolbar the command Change or Repair. 
That command is only shown when the installer of the program supports such 
functionality. Executing it will open a window, letting you change the modules of the 
installed program or repair its installation in case it does not work properly. 
 
 If there are some kind of general problem with the listing of all installed programs 
and the Refresh command does not fix it, you may try to rebuild the cache file that keeps 
the data of the list. Use the command:   
 

Main menu -> File ->Rebuild cache file 
 
NOTE: Rebuild cache file resets you custom changes on the list of all installed 
program, so your comments , custom changed icons and groups associations of hte 
programs will be erased. You will see a warning message .  
 
 

3.1.1. Uninstall 
 
 The main command you can use on the list of installed programs is Uninstall. 
Selecting a program and pressing Uninstall toolbar button will show up the Uninstall 
Wizard. 
 
 Firstly, in background, Revo Uninstaller Pro will try to find a matching traced log or 
logs to the program you are uninstalling. It searches among the logs you have traced or 
imported and the logs in the Logs Database. If there is more than one log related to the 
program for uninstall, or you have a log, but it is for a previous version of the program you 
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are trying to uninstall,  you will see a window asking you if you want to use found log(s) 
during the uninstall procedure. Otherwise, if there is an appropriate log and Revo 
Uninstaller Pro is going to use it, you will be notified on the second step of the Uninstall 
Wizard, during the analyzing of the initial data.   
 
 After the Uninstall Wizard is shown Revo Uninstaller Pro is going to create a system 
restore point and a full Registry backup (if it is not disabled in Options) and then Revo 
Uninstaller Pro is going to run the built-in uninstaller of the uninstalled program. After you 
have finished uninstallation with the built-in uninstaller, you have to press Scan button to 
continue the uninstall process with Revo Uninstaller Pro.  
 
NOTE: The built-in uninstaller may show up behind other open windows and you may 
need to switch between them by using the Alt+Tab key combination – hold Alt key and 
press Tab. 
 
You can choose the scanning mode before the scan: 

Safe - performs a scan in the Registry and the hard drive to find leftover items that 
are safe to delete. This is the fastest mode; 

Moderate - includes the Safe mode and performs an extended scan to find all of the 
application's leftover information in the most common places of the Registry and the hard 
drive;  

Advanced - includes the Moderate mode and performs a deep and thorough scan to 
find all of the application's leftover information in the Registry and on the hard drive. This 
is the slowest mode. 
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 Pressing Scan button will trigger scanning for leftovers and the results (if any) will 
show up automatically. Revo Uninstaller Pro shows found leftover Registry items first. 
Registry keys and values found as created by the uninstalled program are in bold. Not bold 
keys are considered as not created by the uninstalled program. You can also check mark 
them but they will not be deleted! They have check mark options just because it is easier to 
select the top parent and automatically check mark its sub items – no need to go through all 
of them and check mark them separately, so, whatever you check mark, when you press 
Delete button only check marked bold items are going to be deleted, even when Select All 
button is used.  
 

 
 
Deleted Registry items are backed up, so if you need them later you can restore them using 
the Backup Manager. 
 
 Revo Uninstaller Pro contains advanced algorithms to find leftovers related only to 
the uninstalled program. In some cases these algorithms, especially in Advanced uninstall 
mode, could list some items related to another program. It could happen, but NOT 
necessarily (not always), when you have installed two or more versions of a program, for 
example "Adobe Photoshop CS" and "Adobe Photoshop CS5". In this case the user can 
distinguish the leftovers. It also could happen if you want to uninstall only a component of a 
big software package (i.e. a component of Microsoft Office). In that case Revo Uninstaller 
Pro could list the rest of the components as leftovers, because they are installed in the same 
folder and Revo Uninstaller Pro cannot distinguish them (Excel, PowerPoint, Word etc). It 
is better to use Revo Uninstaller Pro to remove the whole software package instead of a 
component.   
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 Revo Uninstaller Pro also includes safety algorithms and will NOT list some 
leftovers if it decides that deleting them can harm your system. Therefore, although it does 
a better job than Windows Add or Remove Programs application and the built-in 
uninstaller of the application you want to uninstall, it still may miss something due to 
safety and the uninstall mode you choose - Safe, Moderate and Advanced. 
 In Revo Uninstaller Pro we have implemented a lot of protections to make it safer 
and secure, while trying to maximize its accuracy in searching for leftovers. 
 Basically you can easily distinguish the leftovers (by name, by install path) and in 
most of the cases Select All button could be safely used. There are GUIDs and CLSIDs 
(alphanumeric items) which are correct leftovers in 99% of the cases, so you can safely 
delete them. 
 Note that Revo Uninstaller Pro creates a Windows System Restore Point, full 
Registry backup and backs up every item you delete. 
 
There is also a context menu, which you can see by right-mouse clicking on the leftover 
items: 
 Expand All – expands all items of the shown Registry tree – by default it is 
expanded so you may not see any difference first time you use this command; 
 Collapse All – collapses all items of the shown Registry tree; 
 Export All – export shown leftover data to HTML file; 
 Expand selected key – expands only the selected key and its sub items; 
 Collapse selected key – collapses the selected key and its sub items; 
 Uninstall selected key – deletes the key from the system; 
 Mark selected key as Created – marks selected key as created by the program you 
are uninstalling. This feature is useful when you see a Registry key which you are sure is 
created by the program, but not marked as created because of the safety algorithms in Revo 
Uninstaller Pro; 
 
Warning: Be very careful using this command. Mark the key only if you are sure that 
it belongs to the uninstalled program! 
 
 Add to Exclude List – adds the selected key to the exclude list, which protects the 
key from deletion. Excluded keys have red color and you can edit the exclude list from 
options in Revo Uninstaller Pro; 
 Open Registry Key… - open the selected Registry key in Windows Registry Editor 
(RegEdit.exe). 
 
 After finishing removal of the Registry leftovers you can press Next button and 
continue with the file and folder leftovers. Note that Next button may not be available if 
there are no other leftovers found. 
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 Revo Uninstaller Pro shows you found leftover files and folders so you can check the 
results and delete them. You can see the number of leftover files and folders found.  
 Deleted files and folders are moved to the Recycle Bin by default, so you can 
recover them from there. You can change that option from Options -> All Programs.  
 
There is a context menu, which you can use by right mouse-click on a file of folder: 
 Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file 
you click on nothing will happen; 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc; 
 Open Containing Folder – opens the folder that contains selected item in Windows 
Explorer; 
 Export – exports the list of found leftover files and folders to a HTML file. 
 
 You can use Select All button to select all found leftover files and folders at once and 
then use Delete button to delete them. 
 

3.1.2. Quick Uninstall 
 
 Another way to uninstall a program, or a few programs at once, is to use the Quick 
Uninstall command. To use it you have to select one or more programs from the list of 
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installed programs and press the Quick Uninstall button from the Commands toolbar. 
That command will open a window and start the uninstallation of the program(s). 
 

 
 
 The sequence of actions is similar to the regular Uninstall command of Revo 
Uninstaller Pro, but when it comes to the step where you have to review and delete the 
leftovers, the Quick Uninstall operation automatically deletes the leftovers, reporting to 
you the number of deleted leftovers; in case you have selected more than one program for 
uninstall, the uninstallation of the next selected program is automatically started. However, 
the system restore point and the Registry backup are not done again, as it is not necessary, 
because they were done at the beginning. 
 Again, by default, all deleted Registry entries are backed up and any found leftover 
files and folders are deleted to the Recycle Bin 
 

3.2. Traced Programs 
 
 Traced Programs module of the uninstaller shows all logs of installations traced 
using Revo Uninstaller Pro.  
 
 To trace a program with Revo Uninstaller Pro you can right-mouse click on its 
installation (setup) package file and select Install with Revo Uninstaller Pro or press 
Install Programs button on the main toolbar. More details are available at section 3.4 in 
the user's guide. 
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 Depending on the view setting, logs are shown as Icons, List, and with Details such 
as Name, Size, Creation Date, Registry items, Files and Folders, Comment, and Import 
status 
 

 
 
 By default, created logs are shown in Icons view and when you select a log in the 
Description Panel some of the properties of the log like: Icon, Size, Date, Registry items 
and Files and Folders, are shown below. Similar data you may also see when you hover the 
mouse cursor over a log in the list. In that case the data is shown as Tooltip, next to the 
mouse cursor. 
 
 Using the Search field in the upper part of the main window, you can filter the list of 
the programs by name or comment. When you type some text in the Search field, just 
below you will see the number of found programs, matching the search criteria. 
 
 All logs are grouped in two default groups – New Programs and Other Programs. 
Total number of logs is shown on the status bar. 
 You can assign each log to a group by using the context menu, shown on right-
mouse click on a log. Removing a log from a group is also possible from the context menu. 
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Default groups are Internet, Games, Multimedia and Utilities. Additional groups can be 
added from the options - Groups Manager - or directly from: 
  
  Context menu -> Add to Group -> Add new group  
 
 The selected item (with a right-mouse click on it) will be moved to the newly added 
group automatically.  
 
Some other commands available from the context menu are:  

Export Log - Export the files of the log and make them ready for import;  
Delete Log - Deletes the log from the list and all data in the log, but the logged 

program is untouched; 
Add/Edit Comment - Opens a window to add a comment about the log or edit the 

comment if such already exists. The comment is visible in Details view; 
Change Icon - Opens a window to select a new icon for the program shown in the 

list. You can search for an icon any EXE or DLL file; 
Rename Log - Lets you to change the name of the log in the list; 
Edit Log - Open a window allowing you to change all data of the log. For more 

information check section 3.2.4; 
Remove from Group - Removes selected log(s) from its current group. 

 
Settings of the module are located at Options -> Traced Programs 
 
Available commands to work with the logs are: 
 

3.2.1. Uninstall 
 
Uninstallation of a logged program reverts all changes made to the system during its 

installation the way they are logged by Revo Uninstaller Pro. This process includes changes 
to the Windows Registry, files and folders.  

After executing the command uninstalling of Registry items, files and folders begins 
and you can see the progress of the process.  
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The window closes automatically when it completes. By default all changed Registry 
items are backed up. If you want to back up the uninstallation of files and folders you have 
to set the option in Options->Uninstaller 
 

3.2.2. Custom Uninstall 
 
Custom uninstall of logged program allows you to select which changes, made to 

the system during the install of the program, you want to revert. After executing the 
command, the uninstall wizard, with just one or two steps, depending on the items that the 
log consist of, shows up. A tree structure shows all logged (if any) Registry items in the first 
step of the uninstall wizard. The wizard has two windows – the left one shows the tree of 
the Registry keys, and the right one shows the list of the values. There are two counters in 
the lower part of the window. They show the numbers of logged keys and values of the 
program. 
When you click on a key in the tree, if it has any logged values, they are shown in the list.  
The different colors and fonts of items are giving more information about the items like: 

Bold item – logged by Revo Uninstaller Pro as created by the installed program 
Red item – the item is excluded from the process of uninstall (the list of excluded 

items is shown in the Options->Uninstaller->Traced Programs->Registry tab) 
Grayed item – the item does not exist in the system at the moment 
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You have to check mark items that you want to uninstall. If you want to uninstall all of them 
you can use the Select All button to check mark them all. But, whatever you have 
marked, only bold checked mark items will be uninstalled. 
 
 To start the uninstall process, press Uninstall button, and you will see the progress 
of the operation.  
 
There are some commands available from the context menu of the tree: 

Expand All – expands the whole tree so the whole hierarchy of keys is visible; 
Collapse All – collapses the whole tree making “My Computer” the only visible item;  
Export All – export shown leftover data to HTML file; 
Expand selected key – expands only the current key making all its sub items 

visible; 
Collapse selected key – collapses only the current key making its sub items 

invisible; 
 Uninstall selected key – uninstalls the selected key. The command is executed no 

matter if the key is check marked or not; 
Mark selected key as Created – marks the selected key as if it is created by the 

program so it will be removed during the process of uninstall;  
 
Warning: Be very careful using this command. Mark the key only if you are sure that 
it belongs to the logged program! 
 

Add to Exclude List – Adds the full path of the current Registry key to the exclude 
list, thus protecting it from manipulations during the uninstall; 

Open Registry Key – Opens current key in the Windows Registry Editor. 
  
There are two commands available from the context menu of the list of values: 

Uninstall selected values – uninstalls the selected values. To select more than one 
value you can hold left mouse button and press Ctrl key from the keyboard to select 
random values or Shift key to select a group of values; 

Open Parent Registry key – opens the key owner of a selected value in the 
Windows Registry Editor. 
 
 If there are any files and folders in the log you can press the Next button of the 
wizard and you will see the list of logged files and folders. In the lower part of the window 
there are two counters that show the numbers of files and folders of the program that are 
logged by Revo Uninstaller Pro. There is also an option to rename the items that have 
existed before the install of the program and have been renamed during the installation. 
This option is: Execute Rename operations of previously existing on the system files 
and folders. 
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 If you want to uninstall some files and folders, you have to check mark some existing 
file or folders or use the Select All button to check all existing items and uninstall them 
pressing the Uninstall button. 
 
There are two commands available from the context menu of the list of files and folders: 

Open – command on the context menu, acting the same way as if you double click on 
a file or folder in Windows Explorer. Note that if there is no file association for the file you 
click on nothing will happen; 
 Properties – command on the context menu, acting the same way as if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification, etc.; 
 Open Containing Folder – opens the folder, containing the selected item in 
Windows Explorer. 
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3.2.3. Advanced Uninstall 
 

 
 
 While the uninstall of a log is proceeding, Revo Uninstaller Pro may recognize, that 
there is some data, that may be related to the uninstalled program, but was not deleted, 
because it was not logged by Revo Uninstaller Pro during the installation of the program. In 
that case you will see a window with Advanced Uninstall button. The Advanced Uninstall 
feature lets you review and delete the data, Revo Uninstaller Pro suggests to be related to 
the program you are trying to uninstall. If you want to review and eventually delete it, 
press the Advanced Uninstall button. This action will start the Advanced Uninstall wizard, 
which may consist of two steps. First one shows possibly related to the uninstalled 
program keys and values, existing in the Registry, and the second one - possible related 
files and folders on your hard drive(s). 
 
Warning: before deleting data using “Advanced Uninstall” feature, be sure that it is 
related to the uninstalled program or it is created by that program 
 
 If there are possibly related to the uninstalled program Registry items you will see 
the first step of the wizard - tree with Registry items you can uninstall. When you click on a 
key in the tree its values, if any, are shown in the list. The font property of items is used to 
give more information about the items. Such information is: 

Bold item – treated by Revo Uninstaller Pro as related to the uninstalled program 
Red item – the item is excluded from the process of uninstall (the list of excluded 

items is shown in the Options->Uninstaller->Traced Programs->Registry tab) 
 
 You have to check mark items the items you want to uninstall. If you want to 
uninstall all of them you can use the Select All button to check mark them all. Whatever 
you have marked, only bold checked mark items will be uninstalled. 
 
 To start the uninstall operation press Uninstall button and you will see the progress 
of the operation.  
 
There are several commands available from the context menu of the tree: 

Expand All – expands the whole tree, so the entire hierarchy of keys is visible; 
Collapse All – collapses the whole tree making “My Computer” the only visible item;  
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Expand selected key – expands only the current key making all its sub items 
visible; 

Collapse selected key – collapses only the current key making its sub items 
invisible; 

 Uninstall selected key – uninstalls the selected key. The command is executed no 
matter if the key is check marked or not; 

Mark selected key as Created – marks the selected key as if it is created by the 
program so it will be removed during the process of uninstall; 
 
Warning: Be very careful using this command. Mark the key only if you are sure that 
it belongs to the logged program but because by one reason or another is not logged 
by Revo Uninstaller Pro! 
 

Add to Exclude List – Adds the full path of the current Registry key to the exclude 
list, therefore protecting it from manipulations during the uninstall; 

Open Registry Key – Opens the current key in the Windows Registry Editor. 
  
There are two commands available from the context menu of the list of values: 

Uninstall selected values – uninstalls the selected values. To select more than one 
value you can hold left mouse button and press Ctrl key from the keyboard to select 
random values or Shift key to select group of values; 

Open Parent Registry key – opens the key owner of selected value in the Windows 
Registry Editor. 

 
 To see possibly related files and folders on your hard drive(s) you can press the 
Next button of the wizard and you will see the list of files and folders. In the lower part of 
the window there are two counters that show the numbers of shown files and folders. If 
you want to uninstall some files and folders you have to check mark them or use Select All 
button to check all existing items and then uninstall  them pressing Uninstall button 
 
There are two commands available from the context menu of the list of file and folders: 

Open – command on the context menu, acting the same way as if you double click 
on a file or folder in Windows Explorer. Note that, if there is no file association for the file 
you click on, nothing will happen; 
 Properties – command on the context menu, acting the same way as if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification, etc.; 
 Open Containing Folder – opens the folder, containing the selected item in 
Windows Explorer. 
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3.2.4. Manage 
 
The Manage drop down button has few possible commands concerning the log 
 
 Export Log - opens a window to select a path and a name of the exported log file 
you want to create. It exports the selected logs file and data in a single file in “.ruel” format - 
Revo Uninstaller Pro’s own file format for exported logs, so, it is easy to share the log's data 
and import it in Revo Uninstaller Pro, for example, on another computer. For example, if 
you have problems uninstalling Program A or just want to do a better uninstall of Program 
A and a friend of yours has installed and traced the same program and has a log, he can just 
export the log and send it to you. You can import it and use it to uninstall the program just 
as if you have traced it yourself. 
 Import Log - This command opens a window to select a .ruel file for import. It 
imports the data from the exported - .ruel file to the local storage of logs of Revo Uninstaller 
Pro, so, after an import operation, a log with the same name as the imported file will appear 
in your list of Traced Programs and you can operate the log as if it is made by you and you 
have traced the installation of that programs yourself. 
An alternative way to import an exported log file is to double click on it in your file 
manager, during which Revo Uninstaller Pro must be closed. 
 Edit Log - Opens a window that lets you review and edit any aspect of the data 
stored in a log. The opened window has 3 tabs - Properties, Registry Items and Files and 
Folders. 
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  Properties - From this tab you can review and edit some common 
information of the log. You can change the Name, Icon, Author or the Comment of the log. 
Other listed fields are read, but they can be automatically changed if you modify other 
sections of the log. 

 Registry Items - From this tab you can review and modify the logged 
Registry changes of the current log. A tree structure shows all logged (if any) Registry items 
in a window divided by two parts – the left one shows the tree of the Registry keys and the 
right one shows the list of the values. When you click on a key in the tree its values, if any, 
are shown in the list. The context menu commands and the meaning of the colored or bold 
items in the tree and list are the same as described in the Custom Uninstall section 3.2.1. 
All the modifications can be made using the commands from the toolbar of the top of the 
Edit window. Here are the commands: 

  Add Value/Key - To add a key or a value to the log, first you have to 
select a key from the tree that will be the parent of the newly added item. Then, in the 
opened window you have to enter the name and to select the operation; 

  Modify - First you have to select the key or value you want to modify. 
Then, executing the command, you can modify the name or the operation of the item; 

  Delete - Executing this command will delete selected Registry item 
from the log only (not uninstall); 

  Export to HTML - Exports the data from the opened tab to a HTML 
file. 

 
 Files and Folders - From this tab you can review and modify files and 

folders operation of the current log. A list shows all traced operations. The context menu 
commands are the same as the described for the Files and Folders page of the wizard in the 
Custom Uninstall section 3.2.1. All the modifications can be made using the commands 
from the toolbar of the top of the Edit window. Here are the commands 

  Add File/Folder - Executing the command you see a window where 
you have to enter the full path of the item (or select it from your hard drive using the 
Browse button) and to select the operation; 

  Modify - First you have to select the file or folder you want to modify. 
By executing the command you can modify the name or the operation of the item 

  Delete - Executing the command will delete selected item from the log 
only (not uninstall); 

  Export to HTML - Exports the data from the opened tab to a HTML 
file. 

 

3.3. Logs Database 
 
 This is a database of logs of traced programs through the monitoring module of 
Revo Uninstaller Pro made and managed by Revo Uninstaller Pro's team. Those logs are 
stored on our web server and you can easily (with just one click) use them to uninstall 
programs or to uninstall leftovers of already uninstalled program.  



Revo Uninstaller Pro - User's Guide 

30 | P a g e  

 Using a log from the Logs Database is the same as if you have made the log and 
traced the program yourself. Therefore, even installing Revo Uninstaller Pro on a fully 
loaded computer with a lot of installed programs, you can take advantage of the possibility 
for better and complete uninstall  using the logs from the Logs Database, as you only have 
to search for the program you want to uninstall and select Uninstall command.  
 
 You can open the Logs Database from the toolbar button while you are in All 
Programs or Traced Programs module or from the main menu - Modules submenu 
When you open the Logs Database, you will see by default a list of logs compatible to your 
Windows version. In the status bar you see: 
- on the left side the number of the listed logs after they are filtered;  
- on the right side the number of all the logs in the database.  
The database is automatically updated by default. 
 

 
 
Using the Search field in the upper part of the main window, you can filter the list of the 
programs by name. On the right side of the Search field there are two additional options 
that filter the list: 
 Show only logs compatible with your Windows version - when it is checked that 
option filters the logs from the list to the ones that are compatible to your Windows version 
only.  
 Show only XX-bit logs - where XX is 32-bit or 64- bit depending on your Windows 
version. When checked, that option filters the logs from the list to the ones that are made 
on the same type Windows version only. 
 
 In the Logs Database you have only two basic commands - Uninstall and Custom 
Uninstall.  When you select a program from the list and afterwards select any of the 
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commands, its log is first downloaded, then imported to your own logs and then the 
command is executed as if it is your own log.  
 
 Uninstall - Executing this command uninstalls the program you have selected from 
the list using the log from the Logs Database 
 Custom Uninstall - Executing this command shows you the wizard with the traced 
items - Registry items in step 1 and Files and Folders in step 2 and lets you select the items 
you want to uninstall. 
 The meaning and the screens of the commands are the same as in the Traced 
Programs module, so check section 3.2.2 for details. 
 
 For smaller programs you may use a log for any Windows version in order to 
uninstall them properly, so, if the program you are searching for is not listed, you may try 
to remove the check mark for the option Show only logs compatible with your Windows 
version and see if the program will appear in the list. 
 

3.4. Forced Uninstall 
 
 Revo Uninstaller Pro has a very powerful feature called Forced Uninstall.  This 
feature helps  you to locate and remove leftovers of programs that are already uninstalled 
or incompletely installed\uninstalled, but there are still remnants of such programs on 
your computer. It does not matter if the program you want to remove is listed or not in 
Revo Uninstaller Pro or in "Windows Programs and Features" Control Panel application. 
Forced Uninstall gives power to the user while maintaining the safety and accuracy of the 
results. 
 Forced Uninstall requires two parameters to get the job done. At least one of these 
two parameters should be supplied. First parameter is the exact name of the program you 
want to remove or search leftovers for. Because the name you enter is searched in your 
system you must enter an exact name,  so if you enter a wrong name you will get wrong 
results. For example if you want to remove Microsoft Office 2007 you have to enter 
Microsoft Office Enterprise 2007, and not: Office, MS Office, Microsoft! If for some 
specific purposes you need to enter more than one name here you can do that separating 
names with ";". Second parameter is the full path to the program you want to uninstall or 
full path to its install location – to its main folder. You can manually enter the path, but you 
can also use the Browse button to locate a file or a folder related or own by the program 
you want to uninstall. You can enter multiple paths here  

 
Using the Browse button to locate the program’s executable file (exe) or main 

installation folder is recommended. 
 

 You can enter the full path to the install location of an already uninstalled and not 
existing program. This is very helpful when you want to find remnants of already 
uninstalled program. 
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 Upon entering any of the initial parameters Forced Uninstall window will trigger 
Revo Uninstaller Pro to search for a built-in uninstaller of the program you want to 
uninstall and logs possibly related to the program. It searches for logs based on the entered 
name among the logs you have in the Traced Programs as well as the logs in the Logs 
Database module. If both build-in uninstallers and logs are found the results are shown in 
two tabs - Found xx programs and Found xx logs 
 If there is a built-in uninstaller, or several possible uninstallers are found, Revo 
Uninstaller Pro lists them in the same window, so you can choose to run one of them or not. 
Uncheck mark Run selected built-in uninstaller if you do not want to run the built-in 
uninstaller. When Run selected built-in uninstaller is unchecked, pressing Next button 
shows you another window, where Revo Uninstaller Pro first creates a system restore 
point and full Registry backup (if that options is not disabled in Options -> Uninstaller), 
and then starts scanning for leftovers. 
 If there is at least one log found based on the name you have entered it is listed with 
the information: 
 Name - name of the log usually the name of the program; 
 Program Version - if the logs is from the Logs Database you can see its version to 
decide if it is appropriate for you to use it for the uninstall of the program; 
 Windows Version - Windows version on which the log is made, also to help you to 
decide if it is appropriate for you to use it based on your current Windows version; 
 Source - whether the log in found among your local logs in Traced Programs 
module made by you or in the Logs Database module; 
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If you decide to use any of the listed logs in the uninstall process you must select it and 
being sure the check mark Use selected log below the list of found logs is checked press 
the Next button. That action opens a window, where Revo Uninstaller Pro first creates a 
system restore point and full Registry backup (if that options is not disabled in Options -> 
Uninstaller), and then loads selected log data, showing first the Registry items and on the 
next step files and folder. If Use selected log is unchecked, pressing Next button shows 
you another window, where Revo Uninstaller Pro first creates a system restore point and 
full Registry backup (if that options is not disabled in Options -> Uninstaller), and then 
starts scanning for leftovers. 
 
 If you want to run the built-in uninstaller before scanning for leftovers, just select it 
and press Next button. A new window containing 3 steps will show up 
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 Revo Uninstaller Pro will run the built-in uninstaller and, after you finish the 
uninstallation with it, you have to press Scan button to continue the uninstall process with 
Revo Uninstaller Pro. Note that the built-in uninstaller may show up behind other open 
windows and you many need to switch between windows by using Alt+Tab keyboard 
combination – hold Alt key and press Tab. Pressing Scan will trigger scanning for leftovers 
and the results (if any) will show up automatically.  
 Similar window is shown in case you want to use a log for the uninstall, but after the 
backup creation is done it automatically load the data of the logs. In case you have chosen 
to use a log from the Logs Database if there is an Internet connection and Revo Uninstaller 
Pro is allowed to access Internet by your firewall the selected log is downloaded, imported 
and  it data is loaded in the uninstalling wizard. 
Revo Uninstaller Pro first shows you any found leftover Registry items. Registry keys and 
values found as created by the uninstalled program are in bold. Not bold keys are 
considered as not created by the uninstalled program. You can also check mark them, but 
they will not be deleted. They have check mark options just because it is easier to select the 
top parent and automatically its sub items are check marked – no need to go through all 
sub items and check mark them separately. So, whatever you check mark, when you press 
Delete button check marked bold items only are going to be deleted, even when Select All 
button is used! 
 
 Deleted Registry items are backed up, so if you need them later you can restore 
them from Backup Manager. 
 
There is also a context menu you can see by right-mouse clicking on the leftover items: 
 Expand All – expands all items of the shown Registry tree – by default it is 
expanded so you may not see any difference first time you use this command; 
 Collapse All – collapses all items of the shown Registry tree; 
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 Export All – exports shown Registry data to HTML file; 
 Expand selected key – expands only the selected key and its sub items; 
 Collapse selected key – collapses the selected key and its sub items; 
 Uninstall selected key – deletes the key from the system; 
 Mark selected key as Created – marks selected key as created by the program you 
are uninstalling. This feature is useful when you see a Registry key which is created by the 
program for sure, but not marked as created because of the safety algorithms in Revo 
Uninstaller Pro; 
 
Warning: Be very careful using this command. Mark the key only if you are sure it 
belongs to the uninstalled program but because by one reason or another is not 
recognized as created by Revo Uninstaller Pro! 
 
 Add to Exclude List – adds the selected key to exclude lists, protecting the key from 
deletion. Excluded keys have red color and you can edit Exclude List in Revo Uninstaller 
Pro’s options; 
 Open Registry Key… - opens the selected Registry key in Windows Registry Editor 
(RegEdit.exe).  
 
After finishing Registry leftovers removal you can press Next button and continue with the 
file and folder leftovers. Note, that the Next button may not be available if there are no 
other leftovers found. 
 
 Revo Uninstaller Pro shows you found leftover files and folders, so you can check 
the results and delete them. Deleted files and folders are moved to the Recycle Bin by 
default, so you can recover them from there. You can also change that from Options -> All 
Programs. You can also see how many leftover files and folders are found. There is also a 
context menu you can use by right mouse-click on a file of folder: 
 Open – command on the context menu acting the same way as if you double click on 
a file or folder in Windows Explorer. Note that if there is no file association for the file you 
click on, nothing will happen; 
 Properties – command on the context menu, acting the same way as if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc.; 
 Open Containing Folder – opens the folder containing the selected item in 
Windows Explorer; 
 Export – exports the list of found leftover files and folders to a HTML file. 
 
You can use Select All button to select all found leftover files and folders at once and then 
use Delete button to delete them. 
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3.5. Install Programs 
 
 Revo Uninstaller Pro has a feature that allows monitoring installation of a program 
and detecting system changes, occurred during that installation. The process is done in real 
time – simultaneously.  
 
 This feature is very powerful, because, by monitoring system changes during the 
installation, we eliminate the necessity of all the scanning algorithms, needed for 
uninstalling. Scanning algorithms are very good on detecting leftovers, but Revo Uninstaller 
Pro has also safety algorithms that are blocking listing of some leftovers because of system 
safety. 
  

 
 

 
 
 With this feature we monitor system changes and we are sure that the changes are 
made by the installed program.  
 There is a big restriction for using that feature - you cannot install two or more 
programs at the same time or run/start other programs during the installation. You can 
run/start one setup file, which can install many programs but you cannot run many setup 
files. 
 
IMPORTANT: Please, DO NOT run/start any other setup files, programs or anything 
else, which could lead to system changes during the installation of a program! You 
DO NOT need to stop any already running programs before starting the installation 
monitoring. 
 
 Basically, you can do all that, but the log file, created after installation, will contain 
the changes made by other setup files and/or programs too.  
 You can use Custom Uninstall mode on Traced Programs, which allows you to 
mark and uninstall the items you want, so, even if, by mistake, you have started another 
program or setup, you can still remove only the program you want to uninstall. 
 This feature has one more big advantage – because it works in real time, it does not 
require any additional time for the installation of a program. It is very easy to use and 
requires only few clicks to get maximum results. 
 
To install programs through Revo Uninstaller Pro you have two options: 

- Use the Install Programs toolbar button of the uninstaller or Install Programs 
command from the Commands menu of the uninstaller. Browse for the setup 
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file of the program you want to monitor and, as usual, follow the instructions of 
the installation wizard of the program you are installing. 

Or, there is another option: 
- Right-mouse click on the setup file of the program you want to install and choose 

Install with Revo Uninstaller Pro command. Then follow the instructions of 
the install wizard as usual. 

 
 When an installation process is started through Revo Uninstaller Pro, a toolbar like a 
band will be shown at the top of your screen. The installation process will continue in the 
usual way and Revo Uninstaller Pro will monitor system changes during the installation.  
You can replace that band with a little toolbar from 

Options -> Trace programs in compact mode 
 
 When you finish installing the program we advise you to run it (if there are several 
components - run them all) and configure it. This way Revo Uninstaller Pro will log the 
configuration settings and when you uninstall that program it will also remove these 
settings.  
 
 After closing the installed program you have to press Stop button on the Revo 
Uninstaller Pro’s band. Then Revo Uninstaller Pro will suggest a name for the log. That 
name will be listed in Traced Programs tab in the uninstaller. You can change the name if 
it is not so accurate suggestion and press the Save button. 
 
Here is the summary of the steps needed to install programs with Revo Uninstaller Pro: 
 

1. Right-mouse click on the setup file of the program you want to install (or 
use Install Programs toolbar button in Revo Uninstaller Pro) 

2. Install the program as usual 
3. Start and configure the program (programs) 
4. Press Stop and Save buttons on the band (toolbar) 

 
 Some programs require restarting before you are able to run them for the first time. 
In that case you have to Stop monitoring, Save the log and then restart. Revo Uninstaller 
Pro has the ability to detect system restarts and save the log automatically, but in that case 
the name of the log will be the name set by Revo Uninstaller Pro.  
 

3.6. Hunter Mode   
 
Hunter mode is an innovative and flexible feature of Revo Uninstaller Pro, which 
gives you the ability to uninstall, stop or delete only by aiming applications icon 
on the desktop, quick launch toolbar, system tray or opened application with just 

one click. This can be very useful because a lot of applications are loading on start up and 
stay in the system tray without your agreement or you don’t even know which application 
is that. 
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When you press the Hunter mode button on the main toolbar of Revo Uninstaller Pro, the 
current window will disappear and a small blue target window will appear at the right 
upper corner of your screen. Hunter mode is now activated. 
 
There are some main options in Hunter mode, available on its context menu (right-mouse 
click): 

Open main window – opens Revo Uninstaller Pro’s main window and exits Hunter 
mode; 

Auto Start with Windows – sets Hunter Mode to start automatically on Windows 
startup; 

Window's size – there are three available sizes of the current window – Small, 
Middle and Large; 

Transparency - sets the Hunter Mode window’s transparency – 50% by default; 
Help – opens current help page; 
EXIT – exits Revo Uninstaller Pro. 

 
To operate in Hunter mode you have to do the following steps: 
 
1. Press the left mouse button over the blue target window and hold it pressed; 
2. Move the mouse over an item supported by Hunter mode (desktop shortcut, open 
window, icon etc.). While doing so a tool tip is shown with information about the 
application you will select if you release the button; 
3. Release the left mouse button and a menu will show up; 
4. Select desired command from that menu: 
 

Uninstall – start the Forced Uninstall module of Revo Uninstaller Pro; 
Stop Auto Starting – disable the application from auto start when Windows starts; 
Kill – Stop the application; 
Kill and Delete – stop and delete the application;  
Open Containing Folder - Open a new instance of windows explorer and explore 
the directory, where the application is located; 
Search at Google for - Use it to search with Google for the application name, file 

name or the company name - producer of selected application. This command will open 
your default web browser and load the result of current search in the Google web site; 

Properties - Show application's executable file's properties; 
Cancel – Cancel the operation. 
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4. Backup Manager 
 
 Backup Manager helps you manage backup information stored by Revo Uninstaller 
Pro after deletion of Registry entries, files and folders if the necessary options are set. 
Restoring a local restore point, you can restore the whole deleted data, or you can just pick 
and restore a single or few items you need back. If you need more free space you can delete 
a random local restore point or all stored by Revo Uninstaller Pro local restore points. 
 

 
 
 Restore points of deleted by Revo Uninstaller Pro information are created when you 
delete data using the Uninstaller (in All Programs mode or Traced Programs mode) or 
AutoRun Manager tool. 
 By default the option Options->Uninstaller->Back up deleted Registry items is 
turned on and Revo Uninstaller Pro backs up deleted Registry data. Also, by default, deleted 
files and folders are not backed up by the Backup Manager. They are deleted to the Recycle 
Bin, if you want to back them up you have to switch the option Options->Uninstaller-
>Delete files and folders to to Backup folder 
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 The main window of the Backup Manager shows you all local restore points created 
by Revo Uninstaller Pro. By default they are grouped by date of creation and sorted by hour 
of creation. There are some properties for every restore point in the list as: name of the 
operation, size of the backup point, number of items etc. 
 
Available commands are: 
 Restore – After the command is executed, the restore of Registry items, files and 
folders starts and you can see the progress of the process. When it completes the window 
closes automatically; 
 Custom Restore - After the command is executed, you see the restore wizard with 
one or two steps, depending on the items you can restore. If there are Registry items in the 
backup, you will see a tree with Registry items you can restore. You have to check mark the 
items you want to restore, or, if you want to restore all of them, you can use the Select All 
button to check mark them all. To start the restore operation press Restore button and you 
will see a window showing you the progress of restoration. If there are files and folders in 
the backup you can press the Next button of the wizard and you will see the tree of files 
and folders that can be restored. Again, you have to check mark or use Select All button to 
mark items, and then restore them pressing Restore button; 
 Delete - If you execute the command the restore point will be removed from the list 
and the information that it contains will be deleted to the Recycle Bin. If you want to free 
up the space allocated by that restore point you will have to empty your Recycle Bin after 
the deletion; 
 Delete by Time - This opens a window that lets you choose a period of time or a 
specific date and delete all backups created before that period or date. This is a convenient 
way to delete a lot of old backups at once; 
 Delete All - This command is only available from main menu Commands. If you 
execute this command all restore points and information they store will be removed, and 
the list will be emptied. All the information is deleted to the Recycle Bin, so to free up space 
used by the restore points you have to empty the Recycle Bin. 
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5. Tools 
 
 Revo Uninstaller Pro gives you 8 handy and powerful tools to clean up your system. 
You can access them by a toolbar, shown by default, or by the Tools menu. If no Tools menu 
and no toolbar are shown, you have to right-mouse click on the status bar (bottom of Revo 
Uninstaller Pro’s main window) and check mark Menu Bar option, and then you will see 
Tools menu. Some tools depends on the running Windows operating system: 

 Operating System 

 

Windows Tools                                                                         

Windows XP Windows Vista Windows 7 Windows 8 

(Pro) 

Windows 

8.1 

Windows 

Server 

2012 R2 

№ x86 x64 x86 x64 x86 x64 x86 x64 x86 x64 x64 

1 System Restore √ √ √ √ √ √ √ √ √ √  

2 Network Diagnostics √           

3 Network Information √ √ √ √ √ √ √ √ √ √ √ 

4 Security Center √ √ √ √ √ √ √ √ √ √  

5 System Properties √ √ √ √ √ √ √ √ √ √ √ 

6 System Information √ √ √ √ √ √ √ √ √ √ √ 

7 TCP/IP Netstat Command √ √ √ √ √ √ √ √ √ √ √ 

8 On-Screen Keyboard √ √ √ √ √ √ √ √ √ √ √ 

9 Disk Defragmenter √ √ √ √ √ √ √ √ √ √ √ 

10 Services √ √ √ √ √ √ √ √ √ √ √ 

11 Shared Folders √ √ √ √ √ √ √ √ √ √ √ 

12 Group Policy √ √ √ √ √ √ √ √  √ √ 

(Pro) 

√ 

13 Add/Remove Windows Components √ √ √ √ √ √ √ √ √ √  

14 Microsoft Windows Malicious Software 
Removal Tool 

√  √ √ √ √  √  √ √ 

15 Windows Backup and Restore √ √ √ √ √ √ √ √ √ √  

16 Task Scheduler √ √ √ √ √ √ √ √ √ √ √ 

17 Check Disk √ √ √ √ √ √ √ √ √ √ √ 

18 System File Checker √ √ √ √ √ √ √ √ √ √ √ 
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5.1. AutoRun Manager 
 
 Auto Run Manager allows you to manage auto running programs and services on 
Windows startup. With this tool you can not only enable or disable applications from auto 
starting on Windows startup but you can also get more information about a particular 
application set to run when Windows starts. You can get information about the publisher of 
the auto starting program or service, its description, its launch path - where it is saved on 
your computer or the status of the application - if it's running or not. If this information is 
not enough to decide whether to enable or disable the program from auto starting, you can 
get more information about the publisher and the executable file name directly from 
Google with just one right-mouse click. 
 
 When you buy a brand new computer it has no or few applications which are loaded 
at Windows startup. During the time you install new applications to your PC some of these 
applications are installed as auto starting on Windows startup. You can see some of them in 
the "system tray" (near the clock) as small icons. Often such applications are messengers, 
adware, advertisement programs and applications you do not need to start automatically. 
 
 When an application is started it takes resources such as RAM, CPU time. The 
amount of these resources depends on started applications but, no matter how much 
memory and resources it takes, when the number of started applications is bigger the 
slower is your computer. 
 
 If you want a program to start automatically when Windows starts, a common place 
to put the program is in the Startup folder of the Start Menu.  
 
 Some applications like anti-virus, firewalls and system programs must be started on 
Windows startup to keep your system running smoothly and without problems. Get as 
much information for an auto running program as possible and decide whether to enable 
or disable it. 
 
 The most common task you would like to do is to disable/enable an application 
from auto starting when the Windows operation system is started. This can be done with a 
single click; all you have to do is to uncheck/check the check box in front of the application 
name. 
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 You can right-mouse click on the column header and show or hide some of the 
columns. This way you can also choose what to print.  
 
There are several commands you can use in AutoRun Manager: 
 Run - You can run an application, which status is NOT RUNNING just by selecting 
the application in the list of applications and press Run button on the toolbar; 
 
 Kill - You can stop an application, which status is RUNNING just by selecting the 
application in the list of applications and pressing the Kill button on the toolbar; 
 
 Remove - If you want to remove an application from the list and prevent its auto 
loading when Windows is starting, you have to select the application and press Remove 
button from the toolbar. Note, that it is better to uncheck mark it only, because, in that way, 
it will be removed from startup but will remain in the list of AutoRun Manager, so you can 
check mark it again if you need it in future;  
 
 Add – You can add programs to start automatically on Windows startup. 
  Name – Enter the name of the program and that name will appear in 
AutoRun Manager 
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  Command (full path) – full path to the program you want to run 
automatically. You can also add parameters, but if you do so add quotes to the path i.e.: 
“C:\Program Files\VS Revo Group\Revo Uninstaller Pro\revounin.exe” /hunter 
  
Set auto start for: 
 All users – if you want that program to start on every user login; 
 Current user – if you want that program to start when only current user is logged 
Select to auto-start from: 
 Registry: Run – on every startup of Windows – this option will add startup 
setting to Windows Registry, which is common place for auto startups; 
 Registry: RunOnce – only once on the next startup of Windows – this option is 
similar to previous one but will start the program only once and then that Registry key will 
be deleted automatically by Windows; 
 Startup Folder – on every startup of Windows – this option will add a shortcut to 
the program in Startup folder, which is also a common place for startups and is accessible 
from Start menu -> All Programs. 
 
There are more commands you can execute over a selected application:  
 Run Process - run selected application; 
 Kill Process - stop selected application; 
 Search at Google for - use it to search with Google for the selected start up name, 
file name, publisher name or description. This command will open your default web 
browser and load the result of current search in the Google web site; 
 Open containing folder - opens a new instance of windows explorer and explores 
the directory, where the selected application is located; 
 Go to Location - runs "Registry Editor" and opens the Registry key with auto 
starting information of the selected application; 
 Open Registry Key - opens "Registry Editor" and the Registry key with the uninstall 
information of the selected application; 
 Remove selected - remove selected application from the list; 
 Remove all not valid - remove all applications with status NOT VALID from the 
list; 
 Remove all not running - remove all applications with status NOT RUNNING from 
the list; 
 Remove all disabled - remove all disabled applications from the list; 
 Properties - show application's properties; 
 Open Windows Services - Opens the Windows Services management application 
and lets you get more properties and options to manage the services. 
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5.2. Junk Files Cleaner 
 
Junk Files Cleaner allows you to find and remove various types of junk and unnecessary 
files from your computer. Many of the Windows applications create junk files. Normally, 
such files are deleted by the application that had created them as soon as it did not need 
them. However they may remain permanently on your hard drive if there is an unexpected 
termination of the parent application, a system crash, etc. If this happens, it will cause 
reduction of free disk space (even hundreds of megabytes), or may slow down system 
speed and performance. 
 
With Junk Files Cleaner you can select which of your drives to scan and what extension of 
files to scan for. The most common temporary and junk files extensions are built-in, but you 
can also add whatever extension you want. If you don't want to scan a whole drive you can 
only select a particular folder. To do that use the button Scan Folder ...  just above the list 
of drives and as soon as you select a folder the scanning starts. 
 

 
 
Commands of Junk Files Cleaner: 
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Scan - to start scanning for junk files, just press the Scan button from the current 
toolbar or from Command menu. This action will perform a scan operation with your 
current options. A small window appears to wait until the scan is complete. There is a 
"Cancel" button on that window, if you press it the scan process will be interrupted and you 
will only see the junk files found until that moment; 

Delete - after the scan process is completed, all found files are loaded in the list with 
their full path, their name and their size. To delete any file of the shown press Delete button 
and all check files will be deleted; 
There are more commands you can execute over selected file(s): 

Open – open selected file; 
Search at Google for – Use it to search with Google for the name of the selected file. 

This command will open your default web browser and load the result of the current 
search in the Google web site; 

 Open containing folder - Open a new instance of windows explorer and explore 
the directory, where the selected file is located; 

Properties – Show file’s properties; 
Check all items – Set a check in front of all items in the list; 
Uncheck all items –Remove the check in front of all items in the list; 
Check all selected items - Set a check in front of all selected items in the list; 
Uncheck all selected items - Remove the check in front of all selected items in the 

list. 
You can adjust settings on Junk Files Cleaner by pressing Options button in the toolbar or 
from the Tools menu. 
 

5.3. Windows Tools 
 
There are a lot of handy and useful tools and components bundled with every Windows 
operating system. Some of them have complex command line options, others are difficult to 
access. Windows tools give you a fast - one click - access to more than ten tools of Windows, 
which you use in your daily work. Almost all of them are included in Windows XP, 
Windows Vista and Windows 7. 
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5.3.1. System Restore 
 
 System Restore is a component of the Windows operating system you can use to 
restore your computer to a previous state, if a problem occurs, without losing your 
personal data files (such as Microsoft Word documents, browsing history, drawings, 
favorites, or e-mail). System Restore monitors changes to the system and some application 
files, and it automatically creates easily identified restore points. These restore points allow 
you to revert the system back to a previous time. They are created daily and at the time of 
significant system events (such as when an application or driver is installed). You can also 
create and name your own restore points at any time. 
 
 

5.3.2. Network Diagnostics 
 
 Network Diagnostics is a component of the Windows operating system you can use 
to gather and display information about your computer hardware and operating system, 
your internet configuration, and your modem and network adapter configuration. With the 
Network Diagnostics tool, you can perform a scan of your system and test network 
connectivity and whether or not your network-related programs and services are 
functional. It gathers a variety of basic information about the computer system, which can 
be helpful when given to a support person trying to help you troubleshoot your system. 
This tool is available only on Windows XP.  
 

5.3.3. Network Information 
 
 Network Information uses a component of the Windows operating system you can 
use to display all current TCP/IP network configuration values and refresh Dynamic Host 
Configuration Protocol (DHCP) and Domain Name System (DNS) settings, Displays the full 
TCP/IP configuration for all adapters including IP address, MAC address, subnet mask, 
default gateway, Windows Internet Naming Service (WINS) and DNS configuration. 
Adapters can represent physical interfaces, such as installed network adapters, or logical 
interfaces, such as dial-up connections. 
 

5.3.4. Security Center 
 
 Security Center is a component of the Windows operating system you can use to 
check the status of your computer for the three security essentials - Firewall, Virus 
protection software and Automatic Update. If a problem is detected with any of the three 
essentials (for example, if your antivirus program is out of date), the Security Center sends 
you an alert and provides recommendations on how to better protect your computer. 
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5.3.5. System Properties 
 
System Properties is a component of the Windows operating system you can use to do the 
following: 
 
    * View basic information such as your CPU type and RAM memory. 
    * View and change settings that control how your computer uses memory and finds 
certain information. 
    * Find information about hardware and device properties, as well as configure hardware 
profiles. 
    * View information about your network connection and logon profile. 
    * Report system and program errors to Microsoft or your system administrator when 
they occur. 
 

5.3.6. System Information 
 
 System Information is a component of Windows operating system that collects and 
displays system configuration information for local and remote computers. This includes 
information about hardware configurations, computer components, and software, 
including signed drivers and unsigned drivers. System Information is a support tool that 
you can use to quickly locate information about your computer and its operating system 
 

5.3.7. TCP/IP Netstat Command 
 
 TCP/IP Netstat Command is a component of the Windows operating system that 
displays all active TCP connections and the TCP and UDP ports on which the computer is 
listening and displays the executable involved in creating each connection or listening port. 
In this case the executable name is in [ ] at the bottom, on top is the component it called, 
and so forth until TCP/IP was reached. With simple words this command shows which 
applications are connected and on which port to the Internet and which are listening for 
incoming connections. 
 

5.3.8. On-Screen Keyboard 
 
 On-Screen Keyboard is a component of the Windows operating system that displays 
a virtual keyboard on the screen, allowing users with mobility impairments to type data 
using a pointing device or joystick. On-Screen Keyboard is intended to provide a minimum 
level of functionality for users with mobility impairments. You can also use On-Screen 
Keyboard if you think that there is a Key-Logger installed on your PC and all the keys you 
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type are being recorded. On-Screen Keyboard eliminates the possibility of recording typed 
keys. 
 

5.3.9. Disk Defragmenter 
 
 Disk Defragmenter is a component of the Windows operating system that analyzes 
local volumes and consolidates fragmented files and folders so that each occupies a single, 
contiguous space on the volume. As a result, your system can access files and folders and 
save new ones more efficiently. By consolidating your files and folders, Disk Defragmenter 
also consolidates a volume's free space, making it less likely that new files will be 
fragmented. The process of consolidating fragmented files and folders is called 
defragmentation. After defragmentation your hard disk drive will be well-arranged and 
your system will work faster and with ease. 
 

5.3.10. Services 
 
 A service is a type of applications that run in the background. Service applications 
typically provide features such as client/server applications, Web servers, database 
servers, and other server-based applications to users, both locally and across the network. 
Services is a component of Windows operating system you can use to: 
 
    * Start, stop, pause, resume, or disable a service on remote and local computers. You must 
have the appropriate permission to start, stop, pause, restart, and disable services. 
    * Manage services on local and remote computers. 
    * Set up recovery actions to take place if a service fails, for example, restarting the service 
automatically or restarting the computer. 
    * Enable or disable services for a particular hardware profile. 
    * View the status and description of each service. 
 

5.3.11. Shared Folders 
 
 Shared Folders is a component of the Windows operating system you can use to 
manage shared resources over a network, control user access permissions, session activity, 
shared resource properties and to view a summary of connections and resources, uses for 
local and remote computers. With Shared Folders, you can: 
 
    * Create, view, and set permissions for shared resources. 
    * View a list of all users connected over a network to the computer, and disconnect one or 
all of them. 
    * View a list of files that have been opened by remote users, and close one or all of the 
open files. 
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5.3.12. Group Policy 
 
 Group Policy is a component of the Windows operating system that includes policy 
settings for User Configuration, which affect users, and for Computer Configuration, which 
affect computers. Group Policy settings define the various components of the user's 
desktop environment that a system administrator needs to manage, for example, the 
programs that are available to users, the programs that appear on the user's desktop, and 
options for the Start menu. To create a specific desktop configuration for a particular group 
of users, use the Group Policy snap-in. 
 

5.3.13. Add/Remove Windows Components 
 
 Add/Remove Windows Components helps you manage installed Windows 
components on your computer. After Windows OS is installed on your computer, you can 
use the Add/Remove Windows Components to add a Windows component that was not 
included in the original installation, or to remove an existing Windows component that you 
no longer require. 
 

5.3.14. Microsoft Windows Malicious 
Software Removal Tool 

 
 The Microsoft Windows Malicious Software Removal Tool checks computers 
running a Windows operating system for infections by specific, prevalent malicious 
software, and helps remove any infections found. This malicious software includes viruses, 
worms and Trojan horses. When the detection and removal process is complete, the tool 
displays a report describing the outcome, including, if any malicious software was detected 
and removed. 
 

5.3.15. Windows Backup and Restore 
 
 Windows Backup and Restore allows you to make copies of data files for all people 
who use the computer and provides you with the ability to create a system image. You can 
let Windows choose what to back up or you can select the individual folders, libraries, and 
drives you want to back up. A system image includes Windows and your system settings, 
programs, and files. You can use a system image to restore the contents of your computer if 
your hard drive or computer ever stops working. 
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5.3.16. Task Scheduler 
 
 Task Scheduler helps you schedule automated tasks that perform actions at a 
specific time, or when a certain event occurs. It provides the ability to schedule the launch 
of programs or scripts at pre-defined times, or after specified time intervals. Task 
Scheduler maintains a library of all scheduled tasks, providing an organized view of the 
tasks and a convenient way to manage them. 
 

5.3.17. Check Disk 
 
 Check Disk opens a command prompt window to execute the chkdsk.exe Windows 
command. Check Disk verifies the logical integrity of the file system on the Windows 
volume. Check Disk checks for problems related to bad sectors, lost clusters, cross-linked 
files, and directory errors. These types of problems can be caused by system crashes or 
freezes, power glitches, incorrectly turning off a computer, etc.  
 

5.3.18. System File Checker 
 
 System File Checker allows you to scan for and restore corruptions in Windows 
system files, verifying their versions. If it finds a problem, it will attempt to replace the 
problematic files from the Windows DLL Cache. If the file is not in the Windows DLL Cache 
or the DLL Cache is corrupted, you will be prompted to insert the Windows installation 
disk. 
 

 

5.4. Browsers Cleaner 
 
 Your browser makes a detailed record of every web site you've ever visited. It's 
easily accessible from your browser window and simply by pressing a button anyone can 
see where you've been browsing on the web. Revo Uninstaller Pro erases web site history 
of web browsers including Internet Explorer, Firefox, Google Chrome and Opera. With 
Browsers Cleaner you can also delete temporary internet files, which are all the pictures 
you've seen, all the online videos you've watched and all the web pages you've visited. 
Deleting Temporary Internet Files will free a lot of space on your hard disk. 
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 Depending on the history setting you want to cleanup and the browser you have, 
you have to check mark these options and press the Clear toolbar button or the Clear 
command on the Commands menu. For faster check\uncheck of items you can use the 
right-click menu command and check\uncheck all items of specific browser or all items in 
the list. 
 

5.5. Microsoft Office Cleaner 
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 MS Office Cleaner allows you to remove history of most recently used files in MS 
Word, Excel, Access, PowerPoint and Front Page. If you do not want somebody else to 
see your last opened or edited spreadsheets, documents or other files created using MS 
Office, just select those you do not want others to see and click the Clear button. Your most 
recently used files will no longer be listed. Windows also keeps a record of your recent files. 
Use MS Windows Cleaner included in Revo Uninstaller Pro to clear them too. 
 
MS Office Cleaner includes the following options to clarify most recently used files of: 
 
     Microsoft Excel 2000, XP, 2003, 2007, 2010 and 2013 
     Microsoft Word 2000, XP, 2003, 2007, 2010 and 2013 
     Microsoft PowerPoint 2000, XP, 2003, 2007, 2010 and 2013 
     Microsoft FrontPage 2000, XP, 2003  
     Microsoft Access 2000, XP, 2003, 2007, 2010 and 2013 
 
 Depending on the program, which history settings you want to cleanup, you have to 
check mark it and press the Clear toolbar button or the Clear command on the Commands 
menu. For faster check\uncheck of items you can use the right-click menu command and 
check\uncheck all items of in the list. 
 

5.6. Windows Cleaner 
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 Microsoft Windows keeps tracks of many things you do with your computer, like file 
search history when you search for file and folders; recently opened document history; 
open/save history used in standard open/save dialogs from different applications installed 
on your computer; start menu clicks history; last opened Registry key history and more. 
Windows Cleaner allows you to remove all this history and temporary files. It's a useful 
tool, because you can remove all this history from one place quickly and easily. You can also 
empty your Recycle Bin and delete temporary files, freeing more disk space. 
 
Available options of Windows Cleaner are: 
 
      Clear Recent Documents History; 
      Clear Start Menu Run History; 
      Clear Find File History; 
      Clear Printers, Computers and People Find History; 
      Empty Clipboard; 
      Clear “MS Paint” Recent Files History; 
      Clear “MS WordPad” Recent Files History; 
      Clear “Regedit” Last Opened Key History; 
      Clear Common Dialog Open Save Recent History; 
      Clear Common Dialog Last Visited Folder History; 
      Empty Recycle Bin; 
      Delete Windows Temporary Files; 
      Delete Start Menu Click Logs; 
      Delete crash memory dump files; 
      Delete Chkdsk (Check Disk) recovered file fragments; 
 Delete Thumbnail Cache. 
 
Depending on the history item you want to clean up, you have to check mark that option 
and press the Clear button on the toolbar or the Clear command on the Commands menu. 
For faster check\uncheck of items you can use the right-click menu command and 
check\uncheck all items of in the list. 
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5.7. Evidence Remover 
 

 
 
 Deleting your files and folders does not mean that they are gone forever. When you 
empty Windows Recycle Bin your files and folders are just marked as deleted but they are 
not physically erased. There is a chance to recover deleted data from 10 years or older PC 
and this data may be very important and confidential. You can easily get back your 
important documents and other files that you have deleted using any recovery tool or un-
delete program. This is where the Evidence Remover tool of Revo Uninstaller Pro comes. 
Evidence Remover will eliminate all chances to get data back from your hard drive. It will 
forever erase files and folders already deleted, but left physically on your hard disk. No 
matter what tool you or somebody else will use to recover the data, including professional 
and expensive recovery and un-delete tools, the result will always be the same - the data 
erased with Evidence Remover is impossible to recover. 
 
 To erase already deleted files and folders you have to check mark the drive where 
these files are deleted from. Then you have to press the Execute toolbar button or the 
Execute command from the Commands menu.  
 
The process is slow, because the data is overwritten 3 times randomly. The speed depends 
on: 

- Computer Processor (CPU); 
- The size of the selected drive; 
- Running programs; 
- Running security software – anti-virus, Internet Security, etc. 

 
 During the process, the free disk space decreases, because Evidence Remover 
creates a very huge file and writes random data in it. That huge file is deleted at the end of 
the process – the free disk space is restored. 
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5.8. Unrecoverable Delete 
 

 
 
 If you want to securely delete a file or folder and to be sure that no one, with any 
tool, could be able to recover this file or folder, then use Unrecoverable Delete. Deleting 
files and emptying Windows Recycle Bin does not mean these files are gone forever. They 
are still on your Hard Disk Drive or other storage, but marked as deleted. Anyone, with a 
tool available free or commercial, could recover deleted data very easily. Revo Uninstaller 
Pro’s Unrecoverable Delete tool makes this impossible, even if you try to do that with the 
most advanced and expensive tool on the market. Deleting files in Windows means that 
they are marked as deleted and the space they allocated is free to use. This is because, if 
Windows has to physically erase all deleted files, it will take time and will slow down your 
computer. Beside this, there is a lot of system, temporary and other files not so important 
to be unrecoverable. Unrecoverable Delete physically erases all the files and folders and 
that's why it takes more time than simple deleting. 
 
Unrecoverable Delete has the following commands: 

- Add File(s) – using this command you can add files for unrecoverable delete 
from different folders and disk drives;  

- Add Folder – using this command you can add a folder for unrecoverable delete. 
All sub folders and files will be deleted permanently; 

- Delete Forever – executes permanent erasing of the added files and folders. You 
can cancel the process, but files, erased before the cancel will be unrecoverable, 
so please carefully select the files and folder you want to delete. 

 
 The window of the Unrecoverable delete tool supports drag and drop of files and 
folders. Because Revo Uninstaller has administrative rights, programs with lower rights 
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cannot drop files and folders in it. For example, if you run Windows explorer or any other 
file manager with standard user account (not as administrator), you will not be able to drag 
and drop files in Unrecoverable delete tool. 
 

6. Options 
 

 
 

6.1. General 
 
Here you can find some general options of Revo Uninstaller Pro like: 
 Current Language: - drop down box, which you can use to change the localization 
of Revo Uninstaller Pro. Note, that it is set when you install Revo Uninstaller Pro to the 
language you choose on install; 
 Backup Folder: - the folder, where all backups will be stored. You can change the 
place if the drive of the backup folder has no more free space; 
 Check for update on startup – Revo Uninstaller Pro will check if there is a new 
version available by connecting to www.revouninstaller.com on startup, but only once a 
day. No personal information is sent or received. Note, that you have to allow Revo 
Uninstaller Pro to connect to the Internet in your firewall settings; 
 Create daily full Registry backup - Once a day Revo Uninstaller Pro will create a 
full Registry backup on the day it is started; 

http://www.revouninstaller.com/
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 Skip information messages shown by Revo Uninstaller Pro – if you do not want 
to see information messages from Revo Uninstaller Pro enable this option. Information 
messages are messages like “Revo Uninstaller Pro finished scanning for leftovers”;  
 Skip warning messages shown by Revo Uninstaller Pro – if you do not want to 
see warning messages from Revo Uninstaller Pro, enable this option. Warning messages are 
messages like “Are you sure you want to remove selected item?”; 
 Show commands in Windows context menu (Install with ..., Uninstall with...) - 
Revo Uninstaller Pro adds the following options to Windows context menu (right-mouse 
click on a file or a folder): 
 - Install with Revo Uninstaller Pro; 
 - Uninstall with Revo Uninstaller Pro (for folders only). 
If you want to remove these options from the context menu uncheck mark this option. 
Because Windows shell extensions, like these options of Revo Uninstaller Pro, are loaded in 
memory, a system restart may be needed. 
 

6.2. Uninstaller 
6.2.1. General 

 
Here are the main options affecting the whole uninstaller: 
 Set focus on Traced Programs on startup – when Revo Uninstaller Pro is started 
All Programs tab is shown by default; instead, you can show Traced Programs by enabling 
this option; 
 Make a System Restore Point before uninstall – If Windows System Restore is 
enabled Revo Uninstaller Pro requests from it creation of a system restore point; 
 Create a full Registry backup before uninstall - If the option is turned on Revo 
Uninstaller Pro makes full Registry backup, which you can restore from Windows Recovery 
Console; 
 Forcibly stop running executable files during their uninstall – if this is turned 
on, and Revo Uninstaller Pro is trying to uninstall an executable file(s), then Revo 
Uninstaller Pro will try to stop that file(s) forcibly. This will prevent some running files 
from remaining on the system until the next restart or even after that; 
 Backup deleted Registry items – this option will cause all manipulations on 
Windows Registry to be backed up. The backups can be restored from Backup Manager. 
 Delete files and folders: 
This option shows where all deleted files are going: 

- to Backup folder – all deleted files are backed up. This option should not be 
used often, because all programs uninstalled by Revo Uninstaller Pro will be 
moved to the backup folder and this will not decrease the free disk space as it is 
expected. You should go to Backup Manager to restore the files or to delete them 
if you really do not need them anymore; 

- to Recycle Bin – this option is similar to the previous one, except that the files 
are moved into Recycle Bin. We recommend this option, because it is safe, and, if 
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you want to restore some files, you just have to open the Recycle Bin. When you 
empty your Recycle Bin you will get additional free disk space; 

- Permanently – all deleted files and folders are deleted permanently, so you 
can’t restore them later. This is the fastest delete option.  

Show as new programs installed: 
This option shows lastly installed programs in a group named New Programs. New 
programs are always shown at the top of the list of programs. 
  - Last (in days) – you can specify how many days a program is considered as 
a new program; 
  - Since the last startup of the uninstaller – a program is shown only once 
as a new and the next time you run Revo Uninstaller Pro the program will not be in the 
New programs list anymore. 
 

6.3. All Programs 
 
Options here are related to the All Programs tab in the Uninstaller.  
 

6.3.1. General 
 

- Show system updates (not supported in Windows Vista and Windows 7,8) – 
the option shows Windows updates on Windows XP; 

- Show system components – some programs have additional components 
which are removable but marked as a component of another program and by 
default Revo Uninstaller Pro does not list this kind of programs; 

- Only run the built-in uninstaller -  when you select the Uninstall command 
Revo Uninstaller Pro will start only the built-in uninstaller of the selected 
program; 

- Use program's uninstall data to get the Install Date property - if this option 
is turned on Revo Uninstaller Pro gets the installation dates of the installed 
programs from their own Uninstall data written by their built-in uninstalled in 
the Registry. Otherwise it uses other Registry data to get the installation dates 

- Open the Uninstall wizard maximized - this option causes the window of the 
Uninstall Wizard to be shown always maximized for better review of the 
leftovers; 

- Search for an appropriate log before program's regular uninstall - if this 
option is turned on, Revo Uninstaller Pro will search for an appropriate log 
among your logs and the logs in the Logs Database, in order to do a better 
uninstall, while you are uninstalling a program through the All Programs 
module; 

- Check mark all leftovers by default - leftovers as Registry items, files and 
folders, found by Revo Uninstaller Pro, will be check marked automatically. 
NOTE: When Delete button is clicked ONLY check marked bold items will be 
deleted, even if all items are check marked! 
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6.3.2. Registry 
 
 When a program from All Programs tab is uninstalled, Revo Uninstaller Pro shows 
the leftover Registry items and some of the items we know for sure that are not created by 
the uninstalled program, so, we have an exclude list for these items. You are also able to 
add or remove such items (using Add and Remove buttons) or Reset Defaults – remove 
all added and restore all removed items. 
 
A Registry key could be excluded only by adding the full path to the key for example: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
 
There is an option for each Registry key called Include Sub keys, which can be check 
marked. That option will exclude all sub keys of that Registry key – not only the key itself.  
 
In front of each Registry key there is a check box, which is used to enable or disable 
(depending on whether it is check marked or not) the exclusion of a Registry key. If there is 
a check mark the key is considered as excluded. 
 
Exclude list supports wild cards as (?) and (*), which means you can exclude several keys at 
once or without knowing the exact name of that particular Registry key. For example: 

 HKEY_LOCAL_MACHINE\SOFT????\Classes 
This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with SOFT and 
having 4 characters following SOFT word, because the (?) sign means any character. 
   

HKEY_LOCAL_MACHINE\SOFT*\Classes 
This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with SOFT word 
and no matter how they end – any length, any characters after the SOFT word. You can use 
(*) char to replace the whole key name as: 

HKEY_LOCAL_MACHINE\*\Classes 
But this also will exclude the whole branch like: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
HKEY_LOCAL_MACHINE\HARDWARE\Classes 
HKEY_LOCAL_MACHINE\Microsoft\Classes 
HKEY_LOCAL_MACHINE\Your Company\Classes 
HKEY_LOCAL_MACHINE\Anything goes here\Classes 
 

You can also use a combination of (?) and (*).  
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6.4. Traced Programs 
6.4.1. General 

 
 Revo Uninstaller Pro creates log files when a program is installed through Revo 
Uninstaller Pro. These files are saved to a default folder, which can be changed if needed 
(not enough disk space). In the Logs Folder: is shown the current path to the logs, it can be 
changed manually to point to another folder or through the Browse button to select 
existing folder for the logs to be stored. 

- Delete traced program log after uninstall – if the option is check marked after 
the command Uninstall is used to uninstall a traced program, the log of the 
uninstalled program will be deleted. 

 
- Trace programs in compact mode – this option shows a small window on top 

of other windows when a program is installed through Revo Uninstaller Pro – 
with a Stop button and Recording animation. This option is not enabled by 
default and that is why Revo Uninstall shows a big band at the top of the screen 
when a program is installed through Revo Uninstaller Pro. 

 

6.4.2. Registry 
 
 When a program from the Traced Programs tab is uninstalled, Revo Uninstaller 
Pro shows the leftover Registry items and some of the items we know for sure that are not 
created by the uninstalled program, so we have an exclude list for these items. You are also 
able to add or remove such items (using Add and Remove buttons) or Reset Defaults – 
remove all added and restore all removed items. 
 
A Registry key could be excluded only by adding the full path to the key for example: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
There is an option for each Registry key called Include Sub keys, which can be check 
marked. That option will exclude all sub keys of that Registry key – not only the key itself.  
 
In front of each Registry key there is a check box, which is used to enable or disable 
(depending whether it is check marked or not) the exclusion of a Registry key. If there is a 
check mark then the key is considered as excluded. 
 
Exclude list supports wild cards as (?) and (*), which means you can exclude several keys at 
once or without knowing the exact name of that particular Registry key. For example: 

 HKEY_LOCAL_MACHINE\SOFT????\Classes 
This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with SOFT and 
having 4 characters following SOFT word, because the (?) sign means any character. 
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HKEY_LOCAL_MACHINE\SOFT*\Classes 

This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with the SOFT 
word and no matter how they end – any length, any characters after the SOFT word. You 
can use the (*) character to replace the whole key name as: 

HKEY_LOCAL_MACHINE\*\Classes 
But this also will exclude the whole branch like: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
HKEY_LOCAL_MACHINE\HARDWARE\Classes 
HKEY_LOCAL_MACHINE\Microsoft\Classes 
HKEY_LOCAL_MACHINE\Your Company\Classes 
HKEY_LOCAL_MACHINE\Anything goes here\Classes 
 

You can also use a combination of (?) and (*).  
 

6.4.3. Processes 
 
 When a program is installed through Revo Uninstaller Pro some of the processes 
should always be included and logged. You can add processes to be included in the 
monitoring using Add button and specify full path to the process. You can also Remove 
added processes or just uncheck mark them, which will remove them from consideration 
as included. Reset Defaults button will remove all added processes and add default ones. 
 
Exclude Processes works in the same way as Include Processes, except that processes in 
its list are not monitored during the installation of programs. 
 

6.5. Logs Database 
 
Options here are related to the Logs Database Module. 
 
 Automatically update the Logs Database - If this option is checked, the database 
of logs is automatically updated. From here you can always update it manually. Below the 
option you will see the current version of the database located on your computer and the 
last version of the database stored on our server. Next to that information is the Update 
Now button, which will start the update if pressed.  
 

6.6. Groups Manager 
 
 Groups Manager shows all available groups both for All Programs and Traced 
Programs. The groups order is important, because that order is considered during the 
listing of programs – first group at the top of the list is shown first, second is shown second 
and so on. Pressing the header of the list of groups with the left mouse button will sort 
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them alphabetically.  There are buttons, which you can use to move up and down (Move Up 
and Move Down) a group and change their order. There are also other buttons: 

- Add – used to add a new group by entering its name; 
- Rename – used to rename a listed group by selecting it first; 
- Remove – used to remove a group by selecting it first; 
- Reset Defaults – removes all created groups and sets the default groups of Revo 

Uninstaller Pro, which are Internet, Games, Multimedia and Utilities. 
 

6.7. Junk Files Cleaner 
 

6.7.1. General  
 
Delete files to the Recycle Bin - if this option is check marked all junk files are moved 

to the Recycle Bin. This can be considered as additional safety but will not increase the free 
disk space until you empty your Recycle Bin. 

 
Ignore files accessed last 24 hours - this option is enabled by default, because some 

junk and temporary files are in use during the scan for junk files and it is better to leave 
them. 
 

There is a list of patterns (mostly file types), and their description, where you can select 
which pattern to scan for when scan operation is performing. Files matching with a given 
pattern will be shown in the result list only if there is a check mark before the pattern. If 
you remove a check mark, the pattern after it will not be taking into consideration while 
scanning is being done. 

 
 You can also add or remove patterns from the list by using the buttons underneath. 
To add new pattern press button Add and a small window will appear, where you can type 
the desired pattern using wild cards (?,*) and press OK to add it to the list or Cancel to 
ignore operation. 
 
 To remove a pattern, select it in the list and press the Remove button. If you want to 
restore the default built-in patterns, just press Set Default button and all of your patterns 
will be deleted and returned to the default. 

 

6.7.2. Exclude  
 
If you wish to exclude any files contained within any directory from a scan, there is a list 

with patterns of paths on the local drives, where you can select which pattern to be 
scanned while the scan operation is performing. Directories matching with a given pattern 
will be skipped in the scan process only if there is a check mark before the pattern. If you 
remove a check mark, the pattern after it will be scanned for unnecessary files. 
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You can also add or remove patterns from the list by using the buttons underneath. To add 
a new pattern press the Add button and a small window will appear, where you can type 
desired pattern using wild cards (?,*)  and press OK to add it to the list or Cancel to ignore 
operation. 

 
To remove a pattern, select it in the list and press the Remove button. If you want to 
restore the default built-in patterns, just press the Set Default button and all your patterns 
will be deleted and returned to the default 

 

6.8. View 
Some visual aspects of Revo Uninstaller Pro can be changed and adjusted here. 
 
 

6.8.1. General 
 
 From the options here you can adjust whether the toolbars should have text labels 
and if the icons of the toolbars should be small or large. Turn on the Show small icons in 
Details view option if you want to view small icons in Details view of the Uninstaller 
modules and AutoRun Manager. 
Show startup splash screen option controls if the splash screen shown on start up of the 
program, just before the main screen would be shown to the user or not 
Reset main window panels settings command resets position and size of the panels of 
main window of Revo Uninstaller Pro - toolbars, status bar, description panel menu bar 
Reset Details view control settings command resets the customization (all column 
changes) of the details view control on the tools that have such view type like the 
Uninstaller module - All Programs , Traced Programs AutoRun Manager etc. 
 

6.8.2. Theme 
 
 Revo Uninstaller Pro has a Themes support and the themes can be changed from 
here. There is a drop down box where you can choose from a several Visual themes. Just 
beneath the list with the ready themes, there are two buttons that let you make a custom 
theme with your favorite colors. The Custom Background Color lets you choose a custom 
color for the background of all windows in Revo Uninstaller Pro and the Custom Selection 
Color  lets you choose a custom color for the selected elements in different controls and 
lists in Revo Uninstaller Pro. 
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7. Registration and Activation 
 
 Revo Uninstaller Pro has a 30 days free fully functional trial period. You can use it 
during that period without any restriction. At any moment you can check the title on the 
top of Revo Uninstaller Pro main window to see how many days you have until the end of 
the trial period. For this, Revo Uninstaller Pro must be started; or another way, again, when 
Revo Uninstaller Pro is started, you may go to the Main Menu on the top of the main 
window -> Help Menu-> About Command 
 When the free trial period is over, if you want to continue using Revo Uninstaller 
Pro, you must purchase a valid license from our web site – www.revouninstaller.com. 
When you purchase a license we send you a Serial Number you must enter in the 
Registration Form in the program, together with your registration name. There are two 
possible ways to activate Revo Uninstaller Pro - to activate it online or to activate it by the 
file generated by Revo Uninstaller Pro. 
 

7.1. Activate Online 
 
 To activate Revo Uninstaller Pro online you must first select that option from the 
Registration window (it is selected by default), and Revo Uninstaller Pro must have 
permissions to access the Internet, which means it should not be blocked from your 
firewall.  
To open the Registration Form and enter the Serial Number and your Name you have to: 

1. Run Revo Uninstaller Pro 
2. Go to Help menu 
3. Choose Registration… 

 

 
 
As the Serial Number contains small and capital letters we strongly recommend you 
to Copy and Paste the Serial Number, received by email not to type it letter by letter. 
 
 
 
 

http://www.revouninstaller.com/
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Enter your Registration name and press the Activate Online button. After the Activate 
Online button is pressed you will see a text in the registration window saying that Revo 
Uninstaller Pro is trying to be activated; and in a few seconds the status of the registration 
may be seen. Restart Revo Uninstaller Pro to check the registration status again at: 
 - the title bar of the main window of Revo Uninstaller Pro 
 - Help menu -> About command 
 
If the activation is successful you should see - Registered to Your Registration Name 
 
The activation requires an Internet connection, because Revo Uninstaller Pro should 
activate and validate your License by connecting to our registration server.  
 
If your computer does not have an Internet connection, you have another option to activate 
Revo Uninstaller Pro - Activation by File 
 

7.2. Activation by File 
 
 To activate Revo Uninstaller Pro by File first you must select that option from the 
Registration window.  
To open the Registration Form and enter the Serial Number and your Name you have to: 

1. Run Revo Uninstaller Pro 
2. Go to Help menu 
3. Choose Registration… 
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As the Serial Number contains small and capital letters we strongly recommend you 
to Copy and Paste the Serial Number, received by email and not to type it letter by letter. 
Enter your Registration name and press the Save File button. After you save the file, send it 
to us by email and we will send you back the Unlock Key, which you must enter in the 
same Registration Form. After you enter the Unlock Key and press the Activate button you 
will see the status of the registration. Restart Revo Uninstaller Pro to check the registration 
status again at: 
 - the title bar of the main window of Revo Uninstaller Pro 
 - Help menu -> About command 
 
If the activation is successful you should see - Registered to Your Registration Name 
 
If you have any questions or problems activating Revo Uninstaller Pro please do not 
hesitate to contact us at support@revouninstaller.com  or 
registration@revouninstaller.com. Please, include details of your purchase, like full name, 
order id, e-mail and License Key received from us. 
 
 

8. Command Line support 
 
Revo Uninstaller Pro supports command line options and has command processor 
RevoCmd.exe  
 
RevoCmd.exe can be used to list installed programs on a computer. It could be used to list 
programs by a part of the name. It could also show the install location and the uninstall 
command of the program which could be then used to start the built-in uninstaller of the 
program. 
 
Usage:  

RevoCmd /m "program name" [/i] [/u] [/p] 
      /m - Match program name using wildcard characters - * and ? 
              The asterisk (*) wildcard represents any collection of characters 
               The question mark (?) wildcard represents any single character 

            Example: RevoCmd /m Microso* 
              Shows all programs beginning with the name Microso 
      /i - Include Install Location if exists 

    /u - Include Uninstall command 
      /p - Pause on each page 
      /? or /help - This help 
 
Some operations of Revo Uninstaller Pro can be executed from command line. Supported 
command line operations and their arguments are: 
 

mailto:support@revouninstaller.com
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Regular Uninstall - you can uninstall programs listed in Revo Uninstaller Pro from 
command line. The uninstall process does not start the built-in uninstaller of selected 
program and deletes automatically Registry items, files and folders found as created by the 
program. 
 
Syntax: 
RevoUninPro /mu "Program name" /path "Full program path" /mode "uninstall mode" 
/32 
 
where the parameters are: 
/mu  - "Exact program name as it is listed in Revo Uninstaller Pro" 
/path  - "Full path to the program's installation folder". Program's path must not finish  
    with backslash 
/mode - mode of the uninstall - Safe, Moderate, or Advanced 
/32 or /64 - depending if the program is 32 bit or 64 bit 
 
Example: 
RevoUninPro /mu "Yahoo Toolbar" /path "C:\Program Files\Yahoo Toolbar" /mode 
Moderate /32 
 
Traced Uninstall - you can uninstall traced program using the name of its log. The 
uninstall process reverts all detected system changes 
 
Syntax: 
RevoUninPro /tu "Log name" 
 
where the parameters are: 
/tu - "Exact log name as you have saved it after the tracing of the installation" 
 
Example: 
RevoUninPro /tu "Yahoo Toolbar" 
 
Export - you can export the lists of all installed programs and all traced programs. During 
the export all properties of the programs are exported 
 
Syntax: 
RevoUninPro /export "Full export path" /all /traced /txt /xls /html  
 
where the parameters are: 
/export - "Full path to the export file where the exported data will be stored" 
/all  - "Export the list of all programs" 
/traced - "Export the list of traced programs" 
/txt - "Export the data in TXT file format - text file" 
/xls - "Export the data in XLS file format - Microsoft Excel file" 
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/html - "Export the data in HTML file format - html file" 
 
Example: 
RevoUninPro /export "C:\My data\allprograms.txt" /all /txt 
 
Hunter Mode - you can start Revo Uninstaller Pro in Hunter Mode 
 
Syntax: 
RevoUninPro /hunter 
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9. Restore Full Registry Backup 
 
Revo Uninstaller Pro creates full Registry backup once each day it has been started. It 
creates a full Registry backup on each program uninstall by default, which can be disabled 
from its options. It also creates backup of Registry items removed during uninstalls.  
 
Full Registry backups should be used only if Backup Manager cannot restore 
removed items or Windows does not start properly anymore! 
 

Depending on your operating system the steps of the restore procedure are as 

follows: 

9.1. Windows XP 
 

Option 1: Starting the Windows Recovery Console from the Windows CD-ROM 

If you have not preinstalled the Windows Recovery Console, you can start the computer 

and use the Recovery Console directly from your original Windows installation disc. If your 

computer is already in Windows and you want to add the Windows Recovery Console as a 

startup option, go to the next section "Adding the Windows Recovery Console as a startup 

option." 

1. Insert the Windows CD into your CD drive and restart your computer. If you are 
prompted, select any options required to start (boot) from the CD. 

2. When the text-based part of Setup begins, follow the prompts. Select the repair or 
recover option by pressing R. 

3. If you have a dual-boot or multi-boot system, select the installation that you want to 
access from the Recovery Console. 

4. When you are prompted, type the Administrator password. 

Option 2: Adding the Windows Recovery Console as a startup option 

If your computer starts Windows, you can add the Windows Recovery Console as a startup 

option from the Windows environment. To install the Recovery Console as a startup option, 

follow these steps: 

1. With Windows running, insert the Windows CD into your CD drive. 
2. Click Start and click Run. 
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3. Type the following commands (where X: is the CD Drive letter), and then press 
ENTER on your keyboard. 

X:\i386\winnt32.exe /cmdcons 

Note There is a space before /cmdcons. 

4. Click OK and follow the instructions to finish Setup. 

Note This adds the Windows Recovery Console to the Windows Startup folder. 

5. Restart your computer and select the Recovery Console option from the list of 
available operating systems. 

Option 3: If you have already installed the Recovery Console 

If you have already installed the Recovery Console, you can select it during your usual 

Windows Startup. To run the Recovery Console: 

1. During Startup, select Recovery Console from the startup options menu. 
2. If you have a dual-boot or multi-boot system, select the installation you want to 

access from the Recovery Console. 
3. When you are prompted, type the Administrator password. 
4. At the command prompt, type Recovery Console commands, and then you can refer 

to the commands listed in the "Available commands within Windows Recovery 
Console" section. 

* Select your Windows installation.  
* Type the administrator password. Press enter if you don't have one. 
 
      Enter the following commands: 
      (Assuming you have installed Windows on “Local Disk (C :)”) 
       
Step 1:   CD “C:\Documents and Settings”  
(The above command contains quotation marks and you should type them too) 
 
Step 2:  DIR 
(A list with folder names will show up, you will see your user name – remember it for the 
next step) 
 
Step 3:  CD “XXX\Local Settings\Application Data\VS Revo Group\Revo 
Uninstaller Pro\RegBackup\Daily\” 
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(You should replace XXX with the user name you saw in the previous step, the above 
command contains quotation marks and you should type them also) 
 
OR 
 
Step 3:  CD “XXX\Local Settings\Application Data\VS Revo Group\Revo 
Uninstaller Pro\RegBackup\Last\” 
 
There are two folders with Full Registry Backup. The first folder is named Daily because it 
is created once a day – once each day when Revo Uninstaller Pro is started. Second full 
Registry backup is created on each uninstall of a program. If you are sure that you want to 
restore full Registry backup created before uninstalling of a program use second option for 
Step 3 – Last.  
 
For example, in the following scenario: 

1. Run  Revo Uninstaller Pro for the first time for that day – Daily full Registry 
backup is created 

2. Uninstall a program – Last full Registry backup is created 
3. Uninstall second program – Last full Registry backup is overwritten 
4. Uninstall third program – Last full Registry backup is overwritten 

 
The Daily backup will revert all changes as if no program has been uninstalled. The Last 
backup will revert only the last changes made by uninstalling the last program. 
 
Step 4:  BATCH Restore.dat 
 
Press ENTER after each step! 
 
Step 5:  Remove any Windows CD/DVD and restart your PC 
 
       

9.2. Windows Vista and Windows 7 
 

1. Restart the computer. When the machine first starts again it will generally list some 

equipment installed on your machine, amount of memory, hard drives installed etc. At this 

point you should tap the F8 key repeatedly until you are presented with a Windows 

Advanced Options menu. 

2. On top of the menu select the "Repair Your Computer" option 

3. You will then have to go through a few steps until you see the System Recovery Options 

window 
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4. If you want to restore the Full Registry back up of Revo Uninstaller Pro you have to  

select Command Prompt 

 

Enter (type) the following commands: 

  (Assuming you have installed Windows on “Local Disk (C :)”) 

    Step 1: C: 

    Step 2: CD  Users 

    Step 3: DIR 

                (A list with folder names will show up, you will see your user name – remember it 

for the next step) 

    Step 4: CD “XXX\AppData\Local\VS Revo Group\Revo Uninstaller 

Pro\RegBackup\Daily\” 

                (You should replace XXX with the user name you saw in the previous step, the 

above command contains quotation marks and you should type them too) 

OR 

    Step 4: CD “XXX\AppData\Local\VS Revo Group\Revo Uninstaller 

Pro\RegBackup\Last\” 

 

There may be two folders with Full Registry Backup. First folder is named Daily because it 

is created once a day – once each day when Revo Uninstaller Pro is started. Second full 

Registry backup is created on each uninstall of a program. If you are sure you want to 
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restore full Registry backup created before uninstalling of a program use second option for 

Step 4 – Last. 

 

    Step 5: ren Restore.dat  Restore.bat 

   Step 6: Restore.bat 

 

Press ENTER after each step! 

 

9.3. Windows 8 
 

You have to start the computer in Command Prompt. To do that press the Power button 

and hold the Shift key while selecting the Restart command. Then you should see the 

screen Choose an Option 

 

Then follow the steps 

1. Click on the Troubleshoot button 

2. Click on the Advance Options button 

3. Click on the Command Prompt button 

4. Then you will have to log into your account and you will see the Command Prompt 

window 
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Enter (type) the following commands: 

  (Assuming you have installed Windows on “Local Disk (C :)”) 

    Step 1: C: 

    Step 2: CD  Users 

    Step 3: DIR 

                (A list with folder names will show up, you will see your user name – remember it 

for the next step) 

    Step 4: CD “XXX\AppData\Local\VS Revo Group\Revo Uninstaller 

Pro\RegBackup\Daily\” 

                (You should replace XXX with the user name you saw in the previous step, the 

above command contains quotation marks you should type too) 

OR 

    Step 4: CD “XXX\AppData\Local\VS Revo Group\Revo Uninstaller 

Pro\RegBackup\Last\” 

 

There may be two folders with Full Registry Backup. First folder is named Daily because it 

is created once a day – once each day when Revo Uninstaller Pro is started. Second full 

Registry backup is created on each uninstall of a program. If you are sure that you want to 

restore full Registry backup created before uninstalling of a program then use second 

option for Step 4 – Last. 

 

    Step 5: ren Restore.dat  Restore.bat 

   Step 6: Restore.bat 

 

Press ENTER after each step! 
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10. Frequently Asked Questions (FAQ) 
10.1. General questions 

 
I have used the contact form on your site, but I haven’t received an answer from the 
support center. How long should I wait for support? 
 
 Our support team will contact you within 24 hours after receiving your message. 
Usually the response time is between few minutes and several hours depending on the load 
of the support team. If after 24 hours you still haven't received a reply then please send 
your query again and be sure that your e-mail address is correctly written. 
 
I am a registered user of Revo Unisntaller Pro 2.x and just bought an upgrade to 
version 3. Should I uninstall the old version first before installing the new one? 
 
We do not recommend you to uninstall version 2 before installing the new version 3, 
because you will lose the current settings of the program. The best approach is to install the 
new version over the existing version, as it will overwrite it and you will keep your data 
and settings, just as it happens with the minor updates.   
 
I have Revo Uninstaller Freeware installed and I bought the Pro version. Should I 
uninstall the Freeware version before installing the Pro? 
 
Both versions of Revo Uninstaller - Freeware and Pro are installed in different folders and 
completely independent. They do not share common components or modules. So it is not a 
problem if you have installed the Pro version and the Freeware is still on you system, but 
the Pro version is superior, so you will not need the Freeware version anymore.    
 
Why "Pin to" is missing on Revo Uninstaller Pro's shortcut and it cannot be pinned to 
Windows 7 taskbar or start menu? 
 The reason for the problem is that Windows 7 does not allow pinning programs 
containing "install" keyword in their name.  You can solve the problem by making a 
shortcut on your desktop of Revo Uninstaller and change the shortcut's name to just "Revo" 
or something else, but the name should not contain "install" as Revo Uninstaller Pro does. 
 
Is Revo Uninstaller Pro compatible with 64 bit Windows version? 
 
 Yes, Revo Uninstaller Pro is fully compatible and provides native support of all 64 
bit Windows versions including Windows 7 and 8. 
 
Why should I use Revo Uninstaller Pro when I have a registry cleaner and it fixes all 
errors in my Windows Registry? 
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 There are tens of thousands of applications that leave a lot of unused data such as 
registry entries, files and folders in your computer. Not all registry keys left in your 
computer are errors, and the third party registry cleaners cannot detect them. Leftover 
registry keys in combination with leftover files makes the registry cleaner's job impossible. 
Revo Uninstaller Pro helps you to remove the leftover registry keys, files and folders after 
uninstalling an application. 
 
How can I close or move the window of the Hunter Mode? 
 
 To close the small blue target window, which appears on the upper right corner of 
the screen when you are in "Hunter Mode", you have to click with the right button of your 
mouse on it and choose Exit or Open Main Window. 
To move the small blue window, which appears on the upper right corner of the screen 
when you are in "Hunter Mode", you have to click with the middle (scroll) button of your 
mouse on it and drag it to the desired location. 
 
I am tracing an installation of a program with Revo Uninstaller Pro, but the 
program's installer ask me to restart the computer. How to proceed? 
 
 If you see such message or request our advice is to stop and save the log with Revo 
Uninstaller Pro (on a system restart if the tracing of Revo Uninstaller Pro is active it will 
save the log with a default name automatically) and to restart your computer. For most 
programs you will have a reliable log, as in such cases all the program data is installed and 
the program wants a restart in order to start its services or modules that are going to be 
started on every Windows start up. 
 

10.2. Registration and licensing questions 
 
Is the license of Revo Uninstaller Pro a lifetime license? 
 
 Purchase of a License includes free lifetime technical support and free updates of 
the program until the next major version, i.e. 3.1.1; 3.5.0, 3.9.9 free updates until version 
4.0. Major version (like 4.0) will include major improvements and major new features. 
Depending on its features you can decide to upgrade by purchasing an upgrade license 
(significant discounts will be applied) or to continue using the purchased version. You can 
continue using the major version for which you have purchased a license for as long as you 
want. 
 
I bought a license of Revo Uninstaller Pro for 1 computer. On how many computers I 
can activate the program? 
 
 Licensing of Revo Uninstaller Pro is per a computer, so buying a license for one 
computer you are allowed to register the program on one computer. II you want to buy a 
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license for 3 or more computers or if you already are our customer, you will be able to buy 
more licenses with a discount. 
 
What kind of license of Revo Uninstaller Pro do I need if I have installed few 
Windows versions on my computer? 
 
 You need a license for one computer as all your Windows installations are on one 
computer. You should not have problems to register the program on any of the supported 
by the program Windows versions. 
 
During the registration process I saw a message "Registration failed". How to 
proceed? 
 
 If by some reason there is a problem with the registration, you can see such 
message, but it should be followed by a sentence with the reason for the problem or with a 
Code of the existed error. Contact our support team with the information about the failed 
status of the registration and we will assist you to solve the problem. 
 
I have changed my computer and now I can't activate Revo Uninsaller Pro on my new 
computer, what to do? 
 
 We are sorry for the inconvenience, but you will have to contact our support team to 
reset your activation on the server. We treat such request with priority, so it usually takes 
from a few minutes to a few hours and less than 24 hours 
 

10.3. Uninstall (remove) programs related 
questions 

 
How to uninstall programs with Revo Uninstaller Pro? 
 
 Before starting to uninstall a program be sure that it is not running. Check your 
taskbar at the bottom of your screen and near your system clock on the right side, if the 
icon of the program you want to uninstall is there right click on its icon and select "Exit" or 
"Quit" or equivalent command to close it. Select the program and start the "Uninstall" 
command. Uninstall process with Revo Uninstaller Pro starts the uninstalling wizard, which 
shows you what is happening on every step of the uninstalling procedure. During the 
uninstall Revo Uninstaller Pro tries to run the built-in uninstaller of the uninstalled 
program, if it works properly let it to do its job, but if it is not working properly you will see 
an error message you will have to skip ( ignore ). Select an uninstall mode and press "Scan" 
button to continue further to the next step of the wizard. After the scanning completes you 
will see the leftover Registry items, files and folders to review, verify and delete them. 
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How to uninstall a traced program with Revo Uninstaller Pro? 
 
 If you have monitored the installation of a program with Revo Uninstaller Pro, then 
the best way to uninstall it is to do that using the created by Revo Uninstaller Pro log. To 
access it you have to open the "Traced programs" module visible as a tab when you start 
Revo Uninstaller Pro. Before starting to uninstall a program be sure that it is not running. 
Check your taskbar at the bottom of your screen and near your system clock, if the icon of 
the program you want to uninstall is there so right click on its icon and select "Exit" or 
"Quit" or equivalent command to close it. Then select the program and start the "Uninstall" 
command. A window will show you the progress of the operation and when that window 
disappear the program will be uninstalled. 
 
How to uninstall a program if I see that there is a log for that program in the Logs 
Database? 
 
 To install a program using a log from the Logs Database is the same as if you 
uninstall this program using your own log. Just select the program from the list of the Logs 
Database and click the "Uninstall" button. This will automatically download and imported 
the selected log. 
 
Is there a way to undo an uninstallation / uninstalling of a program? 
 
 Reinstalling the program is the first and easiest solution. Because Revo Uninstaller 
Pro automatically creates a system restore point before uninstalling a program, you can use 
Windows System Restore to restore your system to a previous state Revo Uninstaller Pro -> 
Windows Tools-> Windows System Restore. By default Revo Uninstaller Pro moves all 
leftover files to the Recycle Bin when you delete them - so check it for accidentally deleted 
files. Also, by default, Revo Uninstaller Pro backs up every deleted leftover Registry item - 
check the Backup Manager of Revo Uninstaller Pro for restore point created after the 
deletion of Registry items you want to restore 
 
How can I stop/remove a program from the Windows system tray? 
 
 Revo Uninstaller Pro has a unique feature called "Hunter Mode". To remove a 
program from the Windows system tray you can use it in the following way: 1. Switch to 
"Hunter Mode" - by default a blue window will appear on the upper right corner of the 
screen 2. Drag (hold the left mouse button) the blue target window to the system tray and 
locate the program you wish to remove 3. Drop (release the left mouse button) the target - 
a menu will appear. Then you can "Kill Process" and it will disappear from the system tray. 
There are other options you may want to use such as: Uninstall, Stop Auto Starting, 
Properties, Open Containing Folder etc. 
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Why can't I uninstall programs without admin rights on Windows Vista/7/8? 
 
 You can't remove programs if you do not have administrator privileges, because 
uninstalling programs will remove files and folders from your system, delete registry keys 
in Windows Registry and could modify the settings of the operating system. The standard 
user account is an account that has privileges only to use the installed programs. 
 
How can I remove a program, which when I try to uninstall it using Windows 
Programs and Feature  (Add or Remove programs) application or Revo Uninstaller 
Pro I see one and the same error message? 
 
 Most probably this error message is generated by the built-in(own) uninstaller of 
the uninstalled program, which Add or Remove programs application tries to run as Revo 
Uninstaller Pro does during the uninstall procedure. In most cases Revo Uninstaller Pro can 
handle the uninstall process even if the built-in uninstaller of the program is not working 
properly. In that case you should start the uninstall procedure with Revo Uninstaller as 
usual and when you see that error message you have to skip(ignore) that message  and 
press the "Scan" button to start scanning for the remnants of the program and continue 
forward the uninstall procedure reviewing and deleting found program's data. 
 
How can I remove a program, which is not listed in Programs and Feature (Add or 
Remove programs) application or Revo Uninstaller Pro list of installed programs? 
 
 If the program is not listed in Revo Uninstaller Pro you can use Forced Uninstall 
feature of Revo Uninstaller Pro, which does not require a program to be installed or listed 
properly - just browse to its folder/file and enter its name. 
 
How to proceed if the program's own /built-in/ uninstaller asks to reboot the 
computer after an uninstallation? 
 
 The best approach is to cancel the reboot and search for leftovers with Revo 
Uninstaller Pro, carefully choose what to delete from the leftovers. After removing the 
leftovers with Revo Uninstaller Pro you can reboot your computer. 
 
Can I use Revo Uninstaller to uninstall accumulated updates for Microsoft Windows? 
 
 Yes, you can use Revo Uninstaller Pro to uninstall Windows updates except updates 
of Windows Vista/7/8 where the updates are not listed by Revo Uninstaller Pro. Note that 
uninstalling Windows updates is NOT recommended, and should be done only if it is 
absolutely necessary. 
 
How can I remove a program which partially installed or uninstalled, but is not listed 
in the list of installed programs? 
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 If the program is not listed in Revo Uninstaller Pro you can use Forced Uninstall 
feature of Revo Uninstaller Pro, which does not require a program to be installed or listed 
properly - just browse to its folder/file and enter its name. 
 
I used Programs and Feature (Add or Remove programs) application to uninstall a 
program several months ago. Can Revo Uninstaller Pro still find possible leftover 
items so I can delete them? 
 
 Yes, Revo Uninstaller Pro can do that. If the program is not listed in Revo Uninstaller 
Pro you can use Forced Uninstall feature of Revo Uninstaller Pro, which does not require a 
program to be installed - just browse to its folder and enter its name. 
 
I am trying to uninstall a program, but during the uninstall procedure the build-in 
uninstaller of the program is reinstalling/repairing it instead of uninstalling it. How 
to proceed?  

 
Cancel the build-in uninstaller of the program and the uninstall wizard of Revo 

10.4. Logs Database module related 
questions 

 
 
 
What is Logs Database? 
 
 It is a database of logs of traced programs through the monitoring module of Revo 
Uninstaller Pro, made and managed by Revo Uninstaller Pro's team. Those logs are stored 
on our web server and you can easily use them (with one click on the "Uninstall” button) to 
uninstall a program or leftovers of already uninstalled program on your computer.  
 
How to uninstall a program if I see that there is a log for that program in the Logs 
Database? 
 
 To uninstall a program using a log from the Logs Database is the same as if you 
uninstall this program using your own log. Just select the program from the list of the Logs 
Database and click the "Uninstall" button.  This will download and import the log selected 
log and uninstall its respective program. 
 

Uninstaller Pro. Then in the list of installed programs right-click on the program name 
select the command Forced MSI Uninstall, that command will start the uninstall 
procedure again, but the build-in uninstaller will try to uninstall the program instead 
of repairing it.  
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Can I use a log from the Logs Database to uninstall a different version of the program 
from the log? 
 
 It depends on the program and how its developers change it among its versions, but 
in most cases you should be able properly to uninstall a program with a version similar to 
the one of the log. For example, if you have Skype 5.2 installed on your computer, you 
should be able to uninstall it properly even using a log for Skype 5.1. That is because of the 
"Advanced Uninstall" technology applied when a traced program is uninstalled through a 
log. It searches for related programs' data not persisted in the log by any reason.  
 

10.5. Questions related to other cleaning or 
optimization tools 

 

How can I scan with Junk Files Cleaner for a specific file type? 
 
 Go to: "Options->Junk Files Cleaner ->General" and check if the specific file type is in 
the list and if it is checked. If the file extension is not there, click the "Add" button and enter 
the specific file type in the shown window. Click "OK" to confirm, go start the Junk Files 
Cleaner and click the "Scan" button to start scanning. 
 
How can I stop programs that start automatically on Windows startup? 
 
 In the AutoRun Manager, you have to remove the check mark in front of the 
program you want to disable from automatically starting on Windows start up. Conversely, 
to enable it, replace the check mark and it will start automatically on Windows startup. 
 

 

 

 

 

 

 

 

 

 


